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Revision Change Details Issue Date

--

Initial Release - new iDEN Transceiver Operator 
Manual to replace the Operator Manual #3092576 
(obsolete). Manual 3093576 is being replaced by 
manuals specific to each of the RayFish software 
application (e.g., separate manuals for GSM CDMA, 
and iDEN). New iDEN Transceiver software version 
2.0 is incorporated per NR 53164.

16 February 2009

A

 iDEN software release 2.1 incorporated per 
CO0056529. Includes new software features: Pag-
ing Only MS DF, Advanced BTS, synchronization, 
Map Router, and Window Vista Support. The man-
ual’s name has been changed from “Operator Man-
ual” to “Operations Manual” to comply with new 
standard for naming manuals.

05 October 2009

B

iDEN software release 2.2 incorporated per 
CO0088208. Includes new software features: 
Option to display data view results by Session Tag, 
access Advanced BTS from Providers and Sub-
scriber tabs, perform Registration on multiple pro-
viders, Windows 7 compatibility, and remove 
sensitive terminology.

08 August 2011

C iDEN software release 2.3 incorporated per 
CO0103684. Updated release date and release ver-
sion.

23 July 2012

D iDEN software release 2.4 incorporated per NPR-
1262 (C00120525). Updated and released per soft-
ware version 2.4.

17 June 2013
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Warnings and Cautions

High Voltage or Shock

 
This Warning label indicates that the user must not attempt to reach
inside the RayFish unit or place objects inside the housing to prevent
serious injury. Do not expose this equipment to rain or moisture and take
care to avoid spilling liquids into the enclosure.

Restricted Use

 
This Warning label indicates that RayFish is a restricted use item and
can only be sold to authorized law enforcement and government
agencies. RayFish use shall comply with all local, state and federal
statutes and regulations associated with the monitoring of cellular
transmissions. Harris Corporation assumes no liability for any misuse or
improper use of this product and makes no representation as to its
suitability for any specific application. Buyer's right to transfer, sell or
assign this product shall be limited to authorized law enforcement and
government agencies and must be pursuant to the written permission of
Harris Corporation.

Caution - Unsafe Practice

This Caution label warns against unsafe practices and indicates that the
user must not remove or disassemble the RayFish housing (at any time)
to prevent damage to the Equipment.

Caution - Read Manual 

When text appears below a CAUTION label, as above, this indicates that
the user must read the manual for proper procedures to prevent damage
to the equipment.

Note - Information
NOTE

When text appears in a green NOTE box, per this example, this indi-
cates information important for successful operation or understanding.
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How to Use This Manual

iDEN Transceiver Manual and Reference Guide
This manual is organized in several sections, containing equipment setup procedures, configuration 
sequences and operating instructions, with expanded detail on Transceiver functions. Some duplication of 
material occurs throughout the various chapters since each has been developed for independent 
reference. Figures and Tables are numbered with reference to chapters, with the first number representing 
the respective chapter; for example, Figure 2-4 is Figure No. 4 in Chapter 2.

• Checklist RayFish Operation Checklist provides a list of important items to remember during 
equipment setup

• Chapter 1 iDEN Operations, describes operations for iDEN modes, including Registration 
and MS DF

• Chapter 2 Tools, describes other software associated with the iDEN Transceiver, including 
the Database Viewer

• Appendices Provides terms and definitions and system reference information

To ensure successful operational results with the RayFish System, it is essential that the operator be 
acquainted with the system's full functions and capabilities; therefore users are advised to refer to the 
complete iDEN Transceiver Manual prior to launching an operational session.
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RayFish Operation Checklist
Before using the RayFish System and starting an application, observe the following checklist for procedures to 
remember during setup and configuration. 

1.  PC Controller must be connected to the RayFish unit using the provided USB cable.

2.  The RayFish unit must be connected to an AC or DC power source using the corresponding power cable 
provided.

3.  Are the antennas properly installed?

a.  The antenna connections are located on the front panel of the RayFish unit.

b.  When using the StingRay II, verify the Receive Antenna is connected to Rx 3 for iDEN operations.

c.  When using a StingRay II with an iDEN duplexer, a KingFish, or a StingRay I:

•    If a power amplifier is used, an additional transmit antenna will be needed when using a 
StingRay II without a duplexer

•    Use one transmit and one receive antenna for transmit mode operations (such as Registration 
and MSDF), whether a power amplifier is used or not 

d.  If the direction-finding AmberJack is used, it will be connected directly to the RayFish front panel as an 
additional antenna.

4.  Power up the RayFish unit and allow it to complete its startup sequence.

5.  Verify the laptop time and date is correct. This will be used to time-stamp system events.

NOTE
Refer to the RayFish Hardware Manual 7028918 for specific hardware 
setup details, including other devices connected to the system.
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iDEN Transceiver Version 2.0 Features
1.  StingRay II Support with Multi-Transmit — Simultaneously transmit on multiple channels (up to 4), when 

using the StingRay II.

2.  Analyze Neighbors — Analyze Neighbors provides the capability to quickly analyze the neighbors of multi-
ple surveyed channels. The user can view a ranking of neighbors based on surveyed RSSI and commonal-
ity amongst the selected channels’ corresponding Cell IDs. This feature can be used to help determine an 
effective neighbor for transmit operation.

3.  Survey Progress Bar — The Status Bar contains the Survey Progress Bar showing the number and per-
centage of channels surveyed. This progress bar can help the user identify when a survey cycle is complete 
prior to starting an transmit operation.

4.  Clear/Restart Survey — The user can clear all channels in the Auto Survey Environment View and restart 
the Auto Survey. This feature can provide the user with a “fresh” set of survey information.

5.  Bluetooth Connection to KingFish — The user can now connect to the KingFish via Bluetooth.

6.  Harpoon Power Amplifier Support — The iDEN Transceiver provides software control for the Harpoon 
Power Amplifier, as well as real-time status on the state of the Harpoon during operations.

7.  AmberJack W Support — With added support for the Wide Band AmberJack (AJ-W) DF Antenna, the 
iDEN Transceiver now provides direction-finding capability.

8.  Night Mode Display Options — Two new Windows display themes (Gray Night Theme and Green Night 
Theme) have been added to support reduced light emissions from the user interface display.

iDEN Transceiver Version 2.1 Features
1.  MS DF Paging-Only Mode — Subscribers can now be actively paged on the Local LAI to reduce registra-

tion traffic. Paging-only mode provides a lower impact subscriber registration method.

2.  Advanced Base Transceiver Station (BTS) Editor — The Advanced BTS parameters are used to emu-
late a base station as well as provide the capability to configure specific transmitted parameters to increase 
the flexibility of transmit modes.

3.  Advanced Synchronization — The iDEN Transceiver can now synchronize to networks that may be 
unsurveyable because of altitude, distance, or other adverse network conditions.

4.  Map Router Support — Map Router features the ability to route information to mapping software to provide 
a visual representation of the mobile tracking mission. This information includes tracking vehicle location 
and Lines of Bearing from AmberJack.   

5.  Windows Vista Support — The iDEN Transceiver now works with Windows XP and Windows Vista. The 
user should exit the iDEN Transceiver application before switching themes to ensure complete Vista com-
patibility.
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6.  False Harpoon Voltage Standing Wave Ratio (VSWR) Alarms — To avoid triggering a false alarm, the 
iDEN Transceiver has been modified to wait for a period, allowing the hardware to settle before declaring a 
VSWR alarm.

7.  Notification of Corrupt Calibration Table — The iDEN Personal Computer Controller (PCC) now detects 
and reports the presence of a corrupt calibration table within the RayFish platforms. If a warning is gener-
ated, contact customer support immediately.

iDEN Transceiver Version 2.2 Features
1.  View results by Session Tag — Added  the option to display the data view results by Session Tag in the 

Database viewer.

2.  Advanced BTS Access from Providers and Subscribers Tab — Access to the Advanced BTS Options is 
now available from the Providers and Subscribers Tab.

3.  Perform Registration on Multiple Providers — The iDEN Controller now allows the option to perform 
Registration on multiple Providers.

4.  Windows 7 Support — The iDEN Controller now works with Windows 7 (32 bit operating system).

5.  Terminology — The iDEN Controller software is updated to update terminology.
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1-1 WHAT THIS CHAPTER CONTAINS

This chapter contains the steps necessary to operate the RayFish system with the iDEN Transceiver application, 
as well as the Harris AmberJack DF antenna and external Power Amplifier. 

1-2 SUPPORTED OPERATING SYSTEMS

The iDEN Controller application supports Microsoft® Windows XP (32-bit OS) and Windows Vista®  (32-bit OS), 
and Windows 7 (32-bit OS).

1-3 iDEN TRANSCEIVER INSTALLATION

The iDEN Transceiver application comes pre-installed and tested on the PC. Should the need arise to reinstall or 
upgrade the iDEN Transceiver application on the PC, refer to the Installation Guide included with the application 
software or contact Harris Corporation Wireless Products Group for technical support.

1-3.1 iDEN TRANSCEIVER STARTUP

The following steps prepare for iDEN operation.

Step 1.  Launch the iDEN Transceiver application by selecting it from the start menu or double clicking on 
the desktop icon (see Figure 1-1).

Figure 1-1.  iDEN Transceiver Icon

Chapter

1 iDEN OPERATIONS
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Step 2.  The Startup splash screen (see Figure 1-2) will appear.

Figure 1-2.  iDEN Transceiver Splash Screen

Step 3.  Allow a brief period for iDEN Transceiver to initialize.

Step 4.  Once initialized, the main iDEN Transceiver screen (see Figure 1-3) will appear.

Figure 1-3.  iDEN Transceiver Initial Screen

Step 5.  When using a StingRay II, the Configure Ports dialog will appear. The default is to transmit on Tx 
Port 1. Make sure to set the Transmit Port to a port that is not currently used by other applica-
tions. When no Power Amplifier is connected, Undetected is displayed in the PA column. If a 
Power Amplifier is connected, Configure the Transmit ports accordingly. If no external PA is con-
nected, just Click OK to Close the dialog.
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1-4 MAIN SCREEN FUNCTIONS

This paragraph describes the Main Screen. Operations are configured, started, and stopped using this screen. The 
main window includes the Menu Bar, Toolbar, and Status Bar. This window is comprised of three main views: the 
Hardware Status View, Environment View and the Mode Results View. The example below (see Figure 1-4) 
displays the screen during an Registration mode.

Figure 1-4.  Main Screen Layout

1-4.1 MENU BAR

The menus available on the Menu bar are File, Edit, Modes, Tools, and Help. These menus are shown in 
Figure 1-5 and described in Table 1-1. 

Figure 1-5.  iDEN Transceiver Menu Bar
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Table 1-1.  iDEN Transceiver Menu Descriptions

Name Menu Sub Menu Function Ref 
Para

File

New Database

Prompts the user to optionally save the 
current database, then clears any 
current data, effectively creating a new 
database 

2-2.3

Save Database As
The Save As window opens allowing 
the user to save the current database to 
a specified location 

2-2.3

Exit Exit the iDEN Transceiver —

Edit Subscribers

Opens Subscribers Management 
dialog to allow the user to add, edit, 
remove, import, and export 
subscribers

1-5.1

Providers  Update/create the service provider list —

Preferences Opens Preferences window to allow 
the user to setup specific mode settings

1-8

Session Tag
Opens Set Session Tag window 
allowing the user to label the current 
session

1-9

Configure 
Hardware

Opens Hardware Configuration 
window 

1-7

Mode Registration
Opens Start Registration window 
allowing the user to configure and start 
the Registration mode

1-11

MS DF
Opens Start MS DF window allowing 
the user to configure and start the MS 
DF mode

1-12

Tools Database Viewer Launches the Database Viewer for 
viewing and managing the database

2-2

Configure Map 
Router

Opens the Map Router Configuration 
dialog for connecting the iDEN 
Transceiver to the Map Router 
application (a separate application).

2-3

Perform Self-Test
Commands the SDRs to perform a self-
test and confirm hardware functionality

2-11
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1-4.2 TOOLBAR FUNCTIONS

The Toolbar allows the user access to preferences, different modes of operation, and mode specific actions. The 
toolbar buttons are shown and described in Table 1-2.
 

Tools (Cont) Advanced BTS 
Editor

Emulates a Base Transceiver Station 
and provides the capability to configure 
specific transmitted parameters to 
increase the flexibility of transmit 
modes

1-11
1-12
2-12

Debug Logging

When Debug Logging is enabled, 
critical system information is logged 
and stored for debug processing. It may 
reduce sytem performance. Only 
enable Debug Logging when instructed 
by the product support team.

—

Help About
General information about the system, 
including software versions of loaded 
applications

1-13

Table 1-2.  Toolbar Buttons

Button Function

Shortcut to Preferences window for general preferences and preferences for all 
modes

Connects to or disconnects from a preconfigured GPS device

Opens Start Registration window allowing the user to specify channels or 
providers to begin Registration and setup Registration preferences. The 
Registration button is only available in the Channels and Providers environment 
views 

Table 1-1.  iDEN Transceiver Menu Descriptions (Continued)

Name Menu Sub Menu Function Ref 
Para
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Opens Start MS DF window, allowing the user to select subscriber on which to 
perform direction finding, allowing them to locate the subscriber by providing a 
bearing to the subscriber and the received signal strength

Suspends Survey, setting the SDRs to idle. The Suspend button is only available 
while Survey is active

Resumes Survey. The Resume button is only available while Survey is suspended

Stops the current mode and returns to Survey. The Stop button is available during 
mode operation

Toggled Off 
(Default)

Toggled On 
(Enabled)

The External PA button is only available when StingRay or KingFish is in use. It 
indicates the Main antenna is used for transmission. When clicked, it toggles from 
the default grey/blue External PA to green/blue External PA to indicate that the 
External PA port is being used for transmission 

Rx: Main Antenna selected. This button allows the user to toggle between Main 
and DF ports for receive during transmit operations

DF Antenna selected. This button allows the user to toggle between Main and DF 
ports for receive during transmit operations. This icon appears when no 
AmberJack is connected to the system

DF Antenna selected. This button allows the user to toggle between Main and DF 
ports for receive during transmit operations, when an AmberJack antenna is 
connected.

Table 1-2.  Toolbar Buttons (Continued)

Button Function
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1-4.3 STATUS BAR

The status bar displays the current power status state of the RayFish hardware as well as other pertinent 
information. Other information includes the number of channels detected during survey, timeline information, and 
current database size. The status bar will be further described in mode specific sections. The status bar is shown in 
Figure 1-4.

1-4.4 HARDWARE STATUS VIEW

The hardware status view provides the user with real-time status of the RayFish system, including detailed views 
for each SDR and the RayFish chassis. Some examples of the hardware status view are shown in Figure 1-6, 
Figure 1-7, Figure 1-8, Figure 1-10, and Figure 1-11.

The first example, Figure 1-6, shows SDR 0, SDR 1, and SDR 2 in Survey operation, while SDR 3 is idle. 

The second example, Figure 1-7, shows detailed hardware information pertaining to SDR 1, including temperature, 
firmware, and calibration data. The iDEN PCC now detects and reports the presence of a corrupt calibration table 
within the RayFish platforms (see Figure 1-9). If a warning is generated, contact customer support immediately.

The third example, Figure 1-8, shows detailed information for the StingRay’s chassis, and power status including 
RFD information. Similar information will be displayed for the KingFish also. 

The fourth example, Figure 1-10, shows SDR 0, SDR 1, SDR 2, and SDR 3 in Survey operation. A PC Peripheral 
GPS is connected, along with a Harpoon, which is currently Muted.

Tx Power icon is displayed during transmit operations.
At anytime during transmission, click the Tx Power button to open a menu to 
adjust power on a channel by channel basis 

Table 1-2.  Toolbar Buttons (Continued)

Button Function
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The fifth example, Figure 1-11, shows detailed information for the StingRay II chassis, and power status including 
RFM information.  

Figure 1-9.  Corrupt Calibration Table Warning

Figure 1-6.  Hardware Status 
View (Status Tab)

Figure 1-7.  Hardware Status 
View (SDR 1 Tab)

Figure 1-8.  Hardware Status 
View (Chassis Tab)
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1-4.5 ENVIRONMENT VIEW

The environment view can be considered the central view of the iDEN Transceiver. The three tabs available in the 
environment view provide the user with important information, as well as an interface for selecting objects to start 
modes of operation. Data can be organized by adding or removing columns, moving and resizing columns within 
the display, and sorting columns by ascending or descending order. Specific details on using the environment view 
can be found in mode specific sections. Some examples of the view are shown below with brief descriptions.

The Channels view (see Figure 1-12) shows the channels and related channel information surveyed during Survey.

Figure 1-10.  Hardware Status View With GPS & 
Harpoon (Status Tab)

Figure 1-11.  Hardware Status View (Harpoon 
Tab)
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Figure 1-12.  Environment View - Channel Tab

The Providers view (see Figure 1-13) shows the providers that have been successfully surveyed.

Figure 1-13.  Environment View - Provider Tab

The Subscribers view (see Figure 1-14) shows the subscribers and identification information currently stored in the 
database.

Figure 1-14.  Environment View - Subscribers Tab
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1-4.6 MODE RESULTS VIEW

The mode results view displays the results of the operating modes to the user. For each mode executed, a tab will 
appear at the bottom of the view providing the user quick, organized access to the results data. As with the 
environment view, data can be organized by adding or removing columns, moving and resizing columns within the 
display, and sorting columns by ascending or descending order. Specific details on using the mode results view 
can be found in mode specific sections. Some examples of the view are shown below with brief descriptions. 
Results can be suspended to stop incoming results from scrolling off screen either by selecting the Suspend Results button or 
simply clicking anywhere on the results view. Select Resume Results to update with the incoming results (including those that 
were suspended.

The Registration results (see Figure 1-15) display the results logged by the StingRay during Registration.

Figure 1-15.  Results View - Registration Tab
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1-5 SUBSCRIBERS

This section describes the iDEN Transceiver's ability to configure and maintain subscribers. Subscribers provide 
the user the ability to connect and locate activity through identification information.

The Subscribers Management dialog allows for display of active and inactive subscribers

• A subscriber can be added, edited, or removed

• A subscriber can also be added from the results view

• A subscribers list can be imported from a file

• A subscribers list can be exported to a file

1-5.1 SUBSCRIBERS MANAGEMENT

When the Edit menu and Subscribers is selected, the Subscribers Management window opens. Active and 
Inactive subscribers are displayed in their corresponding text areas. The Subscribers Management dialog is 
shown in Figure 1-16.

Figure 1-16.  Subscribers Management Dialog

  

NOTE
Multiple subscribers can be selected by single-clicking on the desired rows 
while pressing the Ctrl key. Re-click on highlighted rows to deselect 
subscribers.
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1-5.2 ADDING OR EDITING SUBSCRIBERS

Selecting Add from the Subscribers Management dialog displays the Add Subscriber dialog (see Figure 1-17).

 
Figure 1-17.  Add Subscriber Dialog

Selecting an existing subscriber and Edit from the Subscribers Management dialog displays a populated Add 
Subscriber dialog that can be edited (see Figure 1-18).

Figure 1-18.  Edit Subscriber From Add Subscriber Dialog

Table 1-3 describes the fields and buttons on the Add Subscriber dialog. 

Table 1-3.  Add Subscriber Fields and Buttons

Field/Button Description

Tag Name associated with the subscriber

Specifies whether the subscriber is active or inactive. Inactive subscribers are not 
displayed in the subscribers environment view or matched in mode results

TMSI The Temporary mobile Subscriber Identity as assigned by a Network. This ID is 8 digits 
long
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The following procedure describes how to Add or Edit a Subscriber.

Step 1.  Connect and start the iDEN Transceiver (see Paragraph 1-3.1 for details).

Step 2.  Select Edit menu and Subscribers to open the Subscribers Management dialog (see Figure 1-
16).

Step 3.  Select Add or Edit to open the Add (see Figure 1-17) Subscriber (see Figure 1-18) dialog.

Step 4.  Supply or change the following information. Use Wildcard characters as appropriate (see Table 1-
4):

IMSI The International Mobile Subscriber Identity as assigned by a Service provider. This ID 
is 15 digits long

IMEI The International Mobile Equipment Identity as assigned by the manufacturer of a 
mobile station. This ID is 15 digits long 

PLMNs The Public Land Mobile Network values indicating the service providers with which the 
subscriber is associated

Opens Add Subscriber window, allowing user to associate a PLMN with the subscriber

Removes the selected PLMN from the subscriber's information

Closes window and saves any changes made

Closes window and does NOT save changes made

Opens description of fields

NOTE
If subscriber information is known, subscriber should be added prior to mode
operation.

NOTE
Wildcards work only in non-subscriber modes.

Table 1-3.  Add Subscriber Fields and Buttons (Continued)

Field/Button Description
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 a.  Tag (Required) – Enter name or identifying information.
 b.  Active – Check to store subscriber as Active, deselect to store subscriber as Inactive.

• TMSI – Enter the Temporary Mobile Subscriber Identity number

• IMSI – Enter the International Mobile Subscriber Identity number

• IMEI – Enter the International Mobile Equipment Identity number 

• PLMNs – Enter Public Land Mobile Network value

Table 1-4.  How to Use Wildcards

Character Description Example Explanation

% (percent)
Matches zero or more 
characters

310% Matches all numbers that start 
with 310 and are within the 
allowed length

%62204165 Matches all numbers that end 
with 62204165 and are within the 
allowed length

_ (underscore)

Matches a single character 125_5075 Matches all numbers that begin 
with 125, end with 5075 and 
have exactly 1 character in 
between

___65075 Matches all numbers that end 
with 65075 and have exactly 3 
characters before
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Step 5.  Click OK to store the entry and close the window or click Cancel to close the dialog without storing 
the subscriber.

1-5.3 IMPORTING SUBSCRIBERS

The following procedure describes how to import a list of subscribers from an existing subscribers file (tgt).

Step 1.  Click Import in the Subscribers Management dialog (see Figure 1-16). The Open window will 
appear (see Figure 1-19).

Figure 1-19.  Browse for Subscriber File

Step 2.  Browse to the desired directory and select the desired *.tgt or *.csv file to import.

Step 3.  Select Open and then Yes from the dialog prompt to confirm the import. 

NOTE
Subscribers can also be added directly from most views for mode results. By
right-clicking on the desired result and selecting Add to Subscribers List the
Add Subscriber window will open with the selected information populated.

NOTE
Importing subscribers overwrites any and all existing subscribers stored in
the database.
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1-5.4 EXPORT SUBSCRIBERS

The following procedure describes how to export subscribers to a subscribers file (.tgt).

Step 1.  Click Export in the Subscribers Management dialog (see Figure 1-16). The Save As window will 
appear (see Figure 1-20).

 
Figure 1-20.  Export Subscribers from Save As Window

Step 2.  Browse to the desired directory and choose an appropriate name for the subscribers file to which 
you are going to export.

Step 3.  Select Save from the window prompt to confirm the export.

NOTE
The Save As defaults to the subscribers folder in the following Location:
<C:\Documents and Settings\All Users\Documents\WPG\Protocols\iDEN\Subscrib-
ers>
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1-6 PROVIDERS CONFIGURATION

This section describes the iDEN Transceiver ability to configure and maintain the Providers from the Provider 
Management window accessed via Edit>Providers (see Figure 1-21).   

Figure 1-21.  Edit Providers 

1-6.1 PROVIDER MANAGEMENT

When the Edit menu and Providers is selected, the Provider Management window opens. The buttons are 
shown in Figure 1-22 and described in Table 1-5.

Figure 1-22.  Provider Management Window  

NOTE
The iDEN Transceiver is preloaded with the providers shown in Figure 1-22

Table 1-5.  Provider Management Window Buttons 

Button Function

Allows the user to Add a new record corresponding to the current Provider

Allows the user to Edit a new record corresponding to the current Provider
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1-6.1.1 Add Provider

Select the Add button from the Provider Management dialog (see Figure 1-22) to open the Add Provider dialog 
(see Figure 1-23). Adding a provider requires prior knowledge of the service provider's PLMNs.

Figure 1-23.  Add Provider Dialog

Select New button in the Add Provider dialog to open the Add PLMN dialog (see Figure 1-24) and associate a 
SID with the specified Provider’s name. Select OK to save the new entry and close the Add Provider dialog.

 Removes the selected record

Allows the user to Import a new record corresponding to the current Provider

Allows the user to Export a new record corresponding to the current Provider

Closes the Provider Management window and saves any changes

Closes the Provider Management window and does not save any changes

Table 1-5.  Provider Management Window Buttons  (Continued)

Button Function
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Figure 1-24.  Add PLMN

1-6.1.2 Edit Provider

Select a provider from the Provider Management dialog (see Figure 1-22) and then select the Edit button to open 
Edit Provider dialog (see Figure 1-25) to edit the selected provider.

Figure 1-25.  Edit Provider Entries

Select New button in the Edit Provider dialog (see Figure 1-25) to open the Add PLMN dialog (see Figure 1-24) to 
associate additional PLMNs with the selected Provider. Edit the current associated PLMN by clicking on the PLMN 
and editing as desired. Select OK to save changes and close the Edit Provider dialog. 

1-6.1.3 Remove Provider

Select a provider from the Provider Management dialog (see Figure 1-22) and then select the Remove button. A 
dialog opens (see Figure 1-26) asking if you are sure you want to delete this provider. Select Yes to delete the 
provider from the list.

Figure 1-26.  Delete Provider
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1-6.1.4 Import Providers 

The following procedure describes how to import a list of providers, overwriting the existing file. 

Step 1.  Select Edit > Providers to display the Provider Management window.

Step 2.  Click Import in the Provider Management window and browse to the appropriate directory and 
select the desired .pvd file to import.

Step 3.  Select Open and then Yes from the prompt to confirm the import.

1-6.1.5 Export Providers

The following procedure describes how to export existing providers to a new file (*. pvd). Exporting to a new file 
name or location creates a backup of the information in the existing file.

Step 1.  Select Edit > Providers to display the Provider Management dialog.

Step 2.  Select Export from the Provider Management dialog. The Save As window appears 
(see Figure 1-27).

Step 3.  Browse to the desired directory and choose an appropriate name for the provider file that is being 
created.

Step 4.  Select Save from the window prompt to confirm the export.

 

Figure 1-27.  Export Providers From Save As Window

NOTE
The Save As defaults to the Providers folder in the following Location:
<C:\Documents and Settings\All Users\Documents\WPG\Protocols\iDEN\Providers>
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1-7 CONFIGURE HARDWARE

This section describes the iDEN Transceiver’s ability to configure associated hardware including the GPS device. 

Step 1.  Select Configure Hardware from the Edit menu on the iDEN Transceiver Toolbar (see Figure 1-
28). The Hardware Configuration dialog appears. 

Figure 1-28.  Configure Hardware Menu Selection

Step 2.  Select the Configure button on the Hardware Configuration dialog to configure the GPS 
connection by launching the Initialize GPS Wizard. Figure 1-29 illustrates the Hardware 
Configuration tab available when using the StingRay or KingFish.      

Figure 1-29.  Hardware Configuration Dialog (StingRay/KingFish)

Step 3.  When using a StingRay II, the Hardware Configuration dialog offers two additional tabs: the 
Antennas tab and the Fans tab (see Figure 1-30).

Figure 1-30.  Hardware Configuration Dialog (StingRay II)
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Step 4.  Select the Configure button on the Antennas tab to display the Configure Ports dialog 
(see Figure 1-31). The user can select the Tx Port they wish to have a transmit antenna connected 
to. By default, the transmit port is set to Tx Port 1. When no Power Amplifier is connected, Unde-
tected is displayed in the PA column. If a Power Amplifier is connected, configure the transmit 
ports accordingly by selecting a port that is not currently in use. Click OK to accept changes and 
Close.

Figure 1-31.  Configure Ports 

Step 5.  The Fans tab displays the options available to the user for controlling the fans of the StingRay II 
(see Figure 1-32). System controlled is the default set by the system. The user may choose to 
change this setting. The fans can be set to run at full speed or to be turned off. Additionally, this 
setting affects how the Harpoon fans run if the Harpoon is connected.

Figure 1-32.  Fans Tab

Step 6.  The GPS tab displays the two GPS configurations available to the user. When a StingRay II is con-
nected, the option to use the StingRay II’s internal GPS will be available to the user, otherwise, the 
default is always the PC peripheral. The PC peripheral option allows the user to configure an 
external GPS, either using bluetooth (pre-configured com port required) or USB. When the Sting-
Ray II internal GPS is selected the Configure button is grayed out (see Figure 1-33).
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Figure 1-33.  StingRay II GPS Tab

1-7.1 GPS CONFIGURATION

Before connecting to a PC Peripheral GPS device, the user should configure the GPS connection to ensure a 
faster and more accurate connection. Utilizing a GPS device in conjunction with the iDEN Transceiver allows the 
user to view and store geocoded data.   

The Configure button on the Hardware Configuration dialog launches the GPS Configuration dialog (see 
Figure 1-34). 

• Follow the instructions on the dialog and then click OK

Figure 1-34.  GPS Connection
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1-8 PREFERENCES

The iDEN Transceiver preferences allow the user to configure settings for each operating mode as well as set up 
audible alerts and highlighting. To open the Preferences dialog (see Figure 1-35), select the Edit menu and 
Preferences.

Figure 1-35.  Preferences Dialog

1-8.1 GENERAL

The General preferences tab allows the user to define preferences having an effect on the entire application. To 
enable audible alerts and color highlighting, select the checkbox (see Figure 1-36).

 

Figure 1-36.  Audible Alerts/Color Highlighting Enabled

NOTE
It is important to note that some preferences configured during mode operation 
may not take effect immediately, but instead when the mode is restarted.
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To enable filtering in all modes, only showing results matching active subscribers, select the checkbox (see Figure 
1-37).

Figure 1-37.  Enable Filtering In All Modes

Select the Configure button to open the Event Configuration dialog (see Figure 1-38).

Figure 1-38.  Event Configuration Dialog

Several events pertaining to each mode are shown in the Event Configuration dialog. To associate a sound with an 
event select the event and select a sound from the Sound menu (Figure 1-39). By default, the iDEN Transceiver is 
pre-configured to alert the user with voice sounds representing each event. Sounds can be previewed by clicking 
on the play button.

NOTE
Additional sounds can be manually added by moving any *.wav file into the 
following folder:
 <C:\Documents and Settings\AllUsers\Documents\WPG\Global\Sounds>.
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To highlight events as they appear in each mode's results view, select the desired event and click the Choose 
button located in the Color section of the Event Configuration dialog. The Color dialog (see Figure 1-40) will open 
and the user can select from the provided basic colors or create a custom color. 

When all of the desired events have been configured for audible alerts and color highlighting, click the OK button in 
the Event Configuration dialog to save changes and return to the Preferences dialog.

General preferences provides the ability to enable searching for Bluetooth devices upon start of the application 
(see Figure 1-41).

Figure 1-41.  Bluetooth Connectivity Dialog

Step 1.  Select the Configure button to open the Bluetooth Preferences dialog (see Figure 1-42). 

Step 2.  Click the Restore button to automatically populate the default Passkey. (The KingFish default 
Passkey is 8675309)

Step 3.  Click OK to accept the Bluetooth Preferences settings.

Figure 1-39.  Select a Sound Figure 1-40.  Color Dialog
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Figure 1-42.  Bluetooth Preferences Window

1-8.2 SURVEY

The Survey tab of the Preferences dialog allows the user to configure settings for the Survey State. For details on 
setting Survey preferences refer to Paragraph 1-10.1.

1-8.3 REGISTRATION

The Registration tab of the Preferences dialog allows the user to configure settings for the Registration mode 
operation. For details on setting Registration preferences, refer to Paragraph 1-11.1.

1-8.4 MOBILE STATION DIRECTION FINDING (MS DF)

The MS DF tab of the Preferences dialog allows the user to configure settings for the MS DF mode operation. For 
details on setting MS DF preferences refer to Paragraph 1-12.1.
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1-9 SESSION TAG

The iDEN Controller allows the user to label a session of data logging. For example, specific operations may be 
labeled to reflect the location of the operation. Applying session tags can be a useful tool for post-processing and 
organizing stored information.

1-9.1 SETTING THE SESSION TAG

When Session Tag is selected from the Edit menu, the Set Session Tag dialog opens. The dialog is shown in 
Figure 1-43 and described below.

 
Figure 1-43.  Set Session Tag Dialog

• To tag the current session, enter a name or identifying information and click the OK button

• This will change replace any existing session tag 

• The current session tag is displayed in the status bar (showing all the time) and is an available field in the 
results view of each operating mode
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1-10 SURVEY

When the iDEN Transceiver is started, Survey automatically executes and characterizes the local iDEN network 
environment. A Base Station Survey, specific to the operation location, should always be performed prior to 
execution of a mode. In addition to logging network parameters, RayFish system uses the Base Station Survey to 
display available channels for the user to select in other modes of operation. A real-time display of survey results is 
provided. All survey results are saved in the database and may be viewed using the Database Viewer.

1-10.1 SURVEY PREFERENCES

Survey preferences can be configured, allowing the user to select the bands of interest and the power level 
thresholds for the configured operation (see Figure 1-44). It is important to note that survey preferences configured 
during operation will not take effect immediately, but instead when a new survey iteration begins. All preferences 
will be remembered during subsequent launches of the iDEN Transceiver. 

 
Figure 1-44.  Survey Preferences

1-10.2 SURVEY OPERATION

Survey can be suspended and resumed by selecting the corresponding buttons on the toolbar  
(see Figure 1-45 and Figure 1-46). 
 

Figure 1-45.  Suspend Button Figure 1-46.  Resume Button
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During Survey, the SDRs will cycle through Idle, Channel Scan (see Figure 1-47) and Survey states 
(see Figure 1-48).

Figure 1-47.  SDRs Idle/Channel Scan Figure 1-48.  SDRs Surveying
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1-10.3 SURVEY RESULTS

The Survey results are displayed in the Environment View. Table 1-6 describes the data columns available in the 
Survey results.

• The Channels tab (see Figure 1-12) displays one row for every channel surveyed, while the Providers tab 
(see Figure 1-13) displays one row for every provider in the current environment

• The displayed data can be organized by adding or removing columns, moving columns within the display, 
and sorting columns by ascending or descending order. It is recommended, the user sort by RSSI 
(max RSSI at top) and select the top row or top 3 rows when using a StingRay II. 

Right Click in the Environment View displays a pop-up menu (see Figure 1-49). 

Figure 1-49.  Clear and Restart

• Clear and Restart – This clears the data from the Environment View and restarts the Survey

Table 1-6.  Survey Results Data Columns

Column Example Explanation

Provider Nextel Wireless Name of the Service Provider

PLMN 316-01 Public Land Mobile Network

Band 800 MHz Frequency range utilized for transmission

Carrier 0x429 Carrier Number (in hex) corresponding to the frequency of the 
iDEN Base Station

Color Code F Unique identifier for each carrier

RSSI -82 Received Signal Strength Indicator

SQE 20 Signal Quality Estimate

Cell ID 6932 Base Station identity with a local area

RNC 0x000013 Regional Network Code

SPC 0x00020058 Service Provider Code

SAID 3 Service Area Identifier

Local LAI 1421 Local Area Identifier

Cell Barred
Yes Indicates if a network or cell has been set to “barred.” This 

occurs when a device or network is locked down or a user’s 
access needs to be limited.

Public Cell Yes Indicates the availability of the cell to mobile devices

Neighbors 0x161-3(2222) Neighbor Carriers - Color codes (Desirability Factors)
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• Show in Advanced BTS Editor – This launches the Advanced BTS Editor dialog
 

1-10.4 SURVEY PROGRESS BAR

The Survey Progress Bar shows the progress of both the Channel Scan and the Survey. During the channel scan 
the user will see where the system is during the 1200 carrier channel scan. After the channel scan is complete the 
survey progress bar will then display where the system is during the survey. This will continue to switch between 
both views until the survey is suspended, restarted or during a transmit mode.

• Survey Progress Bar is displayed on the Status Bar. It shows the number and percentage of channels 
surveyed (see Figure 1-50)

Figure 1-50.  Survey Progress Bar

NOTE
Analyze Neighbors (see Figure 1-49) is available when using a StingRay or 
StingRay II. Refer to Paragraph 2-14 for details.
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1-11 REGISTRATION

The Registration mode attempts to log registrations from iDEN mobile stations (MS) that are within range of the 
RayFish system. The RayFish system emulates the weakest surveyed neighbor(s) of the strongest surveyed iDEN 
Channel(s). If survey data is unavailable, the operator can define Advanced BTS Parameters in order to 
maximize the number of mobile stations that register. The RayFish system transmits modified system information 
messages, including a modified Location Area Identifier (LAI) causing an MS to execute a location update. 
During this process, the RayFish will register the MS to obtain specific IMSI, TMSI, and IMEI information from each 
MS. 

During the Registration mode, a real-time display of each Registration result is provided. Color-coded highlighting 
and optional audible indicators alert the operator when a registration matching a subscriber in the Subscribers 
List occurs. All Registration results are saved in a database and may be viewed using the Database Viewer utility 
included with the software.

1-11.1 REGISTRATION PREFERENCES

There are a number of Registration Preferences that can be setup prior to the start of a Registration and a limited 
number that can be changed during a Registration process. It is important to note that Registration preferences 
changed in the Preferences dialog (see Figure 1-51) or the Start Registration dialog (see Figure 1-52 or Figure 1-
53) become the default startup settings. Any preferences changed during a Registration process will not take effect 
immediately, but instead when the Registration process is restarted. All preferences will be remembered during 
subsequent launches of the iDEN Transceiver.

Figure 1-51.  Registration Preferences
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1-11.1.1 Transmit Options

There are Transmit Options that can be configured prior to the start of a Registration. The following preferences 
can be accessed from either the Preferences dialog (see Figure 1-51) or the Start Registration dialog (see Figure 
1-52 or Figure 1-53).

1-11.1.2 Power Options

When using a StingRay I or a KingFish, the user has the ability to change the default power level from 5-1 (with 5 
being the max), stepping the transmit power in 3dB increments/decrements. The user can choose to enable the 
external PA port as the default transmit port, if an external power amplifier is to be used (see Figure 1-54).

When using a StingRay II, the user has the ability to let the system control the power level (see Figure 1-55). 
Automatic power balancing is a system controlled method that sets the transmit power of the SDRs to the optimal 
power level based on the number of active transmissions. The user can choose to override this feature and set a 
static transmit power regardless of the number of active transmissions. However, disabling this feature is not 
recommended, as it may cause poor transmit quality.

Figure 1-52.  Start Registration (StingRay/
KingFish)

Figure 1-53.  Start Registration (StingRay II) 

Figure 1-54.  Power Options (StingRay/
KingFish)

Figure 1-55.  Power Options (StingRay II)
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1-11.1.3 Display Options

The user can choose whether or not to display the transmission dialog before starting the Registration. The 
Display options are illustrated in Figure 1-56.

Figure 1-56.  Display Options

A sample transmission warning dialog is displayed in Figure 1-57.

Figure 1-57.  Tx Power Unbalanced (StingRay II)

1-11.2 REGISTRATION OPERATION 

Registration can be started through three methods:

• Selecting one or more Carriers from the Channels tab in the environment view

• Selecting one or more Providers from the Providers tab in the environment view

• Selecting one or more Carriers from the Analyze Neighbors results

The following procedure describes how to operate the Registration mode:

Step 1.  Select one or more desired Carriers from the Channels tab in the environment view, the Neighbor 
Analysis view, or select one or more Providers from the Providers tab in the environment view (use 
Ctrl + Click to select multiple rows).
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Step 2.  Click the Registration button on the iDEN Transceiver toolbar. The Start Registration window 
(see Figure 1-58 or Figure 1-59) opens. The channel(s) selected in the environment view are listed 
under the Channels tab. 

Step 3.  When the checkbox for Use Advanced BTS settings for all transmitters is selected, the Config-
ure button is available. The PLMN will have a value and the Provider will be displayed in the col-
umn.

Figure 1-58.  Start Registration (StingRay/
KingFish)

Figure 1-59.  Start Registration (StingRay II)
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Step 4.  Select the Configure button to open the Advanced BTS Parameters window (see Figure 1-60). 

• Use these parameters (see Table 1-7) to emulate a base station 

• All fields are required 

• The RayFish system will transmit the values specified for each of the elements

• Select the Help button for detailed explanations of each field

Figure 1-60.  Advanced BTS Parameters Window 

Table 1-7.  Advanced BTS Parameters Description 

Field/Button Explanation

PLMN Public Land Mobile Network (Combination of Mobile Country Code (MCC) 
and Nationwide Direct Connect (NDC) codes

Band Frequency range used for transmission

Carrier Channel/carrier number, listed in hex format

Color Code
An identification affiliated with each channel, making each channel unique. 
Neighboring base stations will have different color code pairs assigned to their 
channels.

Local LAI1
Local Area Identifier/Local Area Identity 1. The LAI1 is equal to the Local 
LAI and identifies a set of Base Stations within a geographical area. This 
number can range from 1 to 65534.

LAI2
Local Area Identifier/Local Area Identity 2. The LAI2 also identifies a set of 
Base Stations within a geographical area. This number can range from 1 to 
65534.

Cell ID The Cell ID identifies a Base Station within a local area. This number can 
range from 0 to 65535.

SAID Service Area Identifier. The SAID identifies a set of one or more Location 
Areas. This number can range from 0 to 255.
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Step 5.  Edit the fields and select OK to return to the Start Registration window.

• To remove a channel or provider, select the row and click the Remove button (use Ctrl + Click 
to select multiple rows)

• To manually add a channel or provider not already listed, click the Add button. This will open 
the Add Channel dialog (see Figure 1-61) or Add PLMN dialog (see Figure 1-62)

• The Carrier and Color Code fields may be configured for Auto

• For the Add Channel dialog, select the Carrier and the Color Code and click OK

RNC Regional Network Code. This number can range from 0 to (2^35-1). Specify 
the RNC in hex. It must start with 0x. 

SPC Service Provider Code. This number can range from 0 to (8 * 2^32-1). Specify 
the SPC in hex. It must start with 0x.

Load Loads BTS parameters from a file (if available)

Save As Saves selected BTS parameters (*.abc.iden filename extension)

Defaults Loads default BTS parameters (NOTE: This function will overwrite BTW 
parameters for selected fields)

Help Displays chassis, PC version, and SDR information

Apply to All Apply options to all Carriers/channels in the list

OK Accepts changes and closes the window

Cancel Closes the window without accepting changes

NOTE
The user can select as many channels as there are transmitters. Examples:

• KingFish has one Software-Defined Radio (SDR) and up to 
one transmit channel

•  StingRay I has four SDRs and up to one transmit channel

•  StingRay II has four SDRs and up to four transmit channels

Figure 1-61.  Add Channel Figure 1-62.  Add PLMN

Table 1-7.  Advanced BTS Parameters Description  (Continued)

Field/Button Explanation
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• For the Add PLMN dialog, specify the MCC and the NDC

• To set preferences for the Registration mode, select the Preferences tab in the Start 
Registration dialog. For details on setting Registration preferences, refer to 
Paragraph 1-11.1

Step 6.  Once the desired channels and preferences are set up, click the Start button in the 
Start Registration dialog to begin the Registration process.

Step 7.  Selecting Start initiates the data gathering process. Once the data is analyzed and logged and 
before the transmission begins, the user is prompted, by default with the Transmit Validation dia-
log (see Figure 1-64, Figure 1-65 and Table 1-8). This gives the user a chance to confirm what the 
RayFish system is going to transmit. 

• The VSWR alarm will be shown when the reflected power is less than 5dB of the forward 
power. Check that all cable and antenna connections are secure (see Figure 1-63)

 
Figure 1-63.  VSWR Alarm 

NOTE
When starting from the Channels tab it is recommended to use Transmit on 
weakest neighbor of the selected channel (see Figure 1-52). This option 
lets the system choose the most appropriate channel, based on the network 
survey results from the last five minutes. Unselecting this option will tell the 
system to superimpose on the selected channels.

NOTE
When starting from the Analyze Neighbors view, there is no “Transmit on 
weakest neighbor “ option, because the user will specify the appropriate 
choice.
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Figure 1-66.  Registration Transmit Toolbar

• To configure the transmit power level, left click the Tx Power button and select the desired 
level from the drop down menu 

• To enable or disable the External PA, click the External PA button (see Figure 1-67)

Figure 1-64.  Transmit Validation Dialog 
(StingRay/KingFish)

Figure 1-65.  Transmit Validation (StingRay II)

Table 1-8.  Transmit Validation Data Field Description

Column Explanation

PLMN Provider’s ID

Provider The name of the provider associated with the PLMN

Carrier Channel number

Color Code Piece of information used to identify a tower

Tx Power User can change this before transmission (Grayed out when 
automatic power balancing is enabled (Figure 1-65)

Tx Port Allows the user to change Main or Ext PA (StingRay II will 
automatically specify the configured Tx Port)

NOTE
Transmission dialog can be disabled, see Paragraph 1-11.1.3.

NOTE
While registering, the transmit options buttons are shown on the toolbar for on-
the-fly configuration of the Transmit Power and External PA (see Figure 1-66).
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Figure 1-67.  External PA Button

Refer to Paragraph 1-11.3 for details on viewing and understanding the Registration results. To manually switch 
between the Main Rx port and the DF port, click the Antenna Selection button (see Figure 1-68 and Figure 1-69).

Step 8.  To Stop the Registration operation, the Stop button  located on the toolbar.

1-11.3 REGISTRATION RESULTS
• If information matches with a subscriber in the subscribers list, the subscriber tag will reflect the matched 

subscriber

• The subscriber tag may also be highlighted and accompanied by an alert sound, as setup by the user

• Results can be suspended to stop incoming results from scrolling off screen either by selecting the 
Suspend Results button or simply clicking anywhere on the results view. Select Resume Results to 
update with the incoming results (including those that were suspended)

• Subscribers can be added by right-clicking a result, which includes identity information, with results 
suspended (see Paragraph 1-5.2)

• The data can be organized by adding or removing columns, moving columns within the display, and sorting 
columns by ascending or descending order

• Right-click on the column headings to see what columns are available to add/remove

• Left-click and drag to move columns within the display

NOTE
StingRay II will not have an External PA button visible on the Registration 
Mode Toolbar.

Figure 1-68.  Rx Main Antenna Figure 1-69.  Rx DF Antenna

Figure 1-70.  Suspend Results Figure 1-71.  Resume Results
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• Left-click column headings to sort ascending/descending

• The results will remain in the results view under the Registration tab (even if the mode is stopped) until a 
new Registration operation is started or the view is closed normally 

1-11.3.1 Results View

The Results view displays the real-time mobile station registrations (see Figure 1-72 and Table 1-9).

Figure 1-72.  Registration Results View

Table 1-9.  Registration Data Field Description

Column Example Explanation

Time 8:23:27 AM Time the result was registered

Provider Nextel Wireless Name of the Service Provider

Band 800 MHz Frequency range utilized for transmission

Carrier 0x433 Radio Frequency Carrier Number

Color Code 8 Base Station Identifier

Event Type Location Update A sequence of messages from a mobile that is 
identified as a certain event

Subscriber Tag Green Boy Name of Subscriber

TMSI 9E4FE1B9 Temporary Mobile Subscriber Identity. TMSI is MS-
specific.

IMSI 316010... International Mobile Subscriber Identity. TMSI is 
MS-specific.

IMEI 001700... International Mobile Equipment Identity. IMEI is sim 
card specific.

RSSI -63 Relative Signal Strength Indicator

SQE 8 Signal Quality Value
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1-12 MOBILE STATION DIRECTION FINDING (MS DF)

The RayFish System transmits on a common weak channel for the selected Subscriber’s Provider. Once a 
subscriber is connected, RSSI measurements are to be taken from the DF antenna to provide direction to the 
subscriber. 

In the MS DF mode, the RayFish System commands the MS to raise its power output level to the highest setting at 
which the MS can transmit. The RayFish system will keep the MS engaged until the operator stops MS DF, or until 
interference/distance cause the signal to be lost.

1-12.1 MS DF PREFERENCES

Mobile Station Direction Finding (MS DF) preferences (see Figure 1-73) can be set up prior to, or at anytime during 
execution. It is important to note that MS DF preferences configured during operation will not take effect 
immediately, but instead when the MS DF process is restarted. The user can configure the Transmit options, 
Direction finding options, Audible RSSI options, and Paging Only option. All preferences will be remembered 
during subsequent launches of the iDEN Transceiver. 

The Paging Only option is used to limit the number of mobile registrations when running an MS DF. This should be 
used in dense areas where a large number of mobile registrations can occur. When using this option, the RayFish 
system will page only the subscriber mobile, using the same LAI as the network.

Figure 1-73.  MS DF Preferences
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1-12.1.1 Transmit options

Step 1.  Select the Configure button to access the Transmit Options dialog (see Figure 1-74 and 
Figure 1-75). 

• StingRay II provides the selection to Enable automatic power balancing 

• Automatic power balancing is used during a multiple transmit mode

• Depending on the number of active transmissions, the controller will set the SDRs to a specific 
transmit power to achieve optimal performance

• This can be overridden during a mode or can be unchecked from the active transmission 
preferences before starting a mode. However, this is not recommended

Step 2.  Select desired Power options and Display options.

Step 3.  Select OK to accept the changes and close the Transmit Options dialog.

1-12.1.2 Direction Finding Options

The user has the option to enable/disable bearing averaging. Bearing averaging will take the average of a preset 
number of bearings to create the final bearing measurement. If this option is disabled, then each bearing 
measurement will be displayed and the bearings may seem sporadic.

The user selects Configure (see Figure 1-76) to access the Direction Finding Options dialog.

Figure 1-76.  Direction Finding Options

Figure 1-74.  Transmit Options Dialog 
(StingRay/KingFish)

Figure 1-75.  Transmit Options (StingRay II)
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 The Direction Finding Options dialog (see Figure 1-77) provides the following:

The RSSI bar range area on the Direction Finding Options dialog (see Figure 1-77) provides the following 
options:

• Maximum – Set the maximum value from the range of -150 dB to 40 dB for the RSSI bar display

• Minimum – Set the minimum value from the range of -150 dB to 40 dB for the RSSI bar display

• Increment – Set the increment at which tick marks will be displayed

• Show peak – Select checkbox to show the peak RSSI received

• Show labels on side – Select checkbox to enable the RSSI bar to draw its labels next to the power 
display

The RSSI bar colors area on the Direction Finding Options dialog (see Figure 1-77) provides the following:

• The color of the RSSI bar can be specified by clicking the Bar Color button from the RSSI bar colors area 
and selecting a color (see Figure 1-79)

• The color of the RSSI bar can be specified by clicking the Bar Color button from the RSSI bar colors area 
and selecting a color (see Figure 1-79)

Figure 1-77.  Direction Finding Options Dialog
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The RSSI bar area (see Figure 1-79) on the Direction Finding Options window provides the following options:

• Show additional auto-scaling RSSI bar when no AmberJack is present – Select checkbox to enable

• Center Current RSSI within (dB) – Selectable number with 5 the default

• Recenter interval (sec) – Selectable number with 1 the default

The Compass drawing style area (see Figure 1-80) on the Direction Finding Options window provides the 
following:

Figure 1-80.  Compass Drawing Style

• Compass face – Radio button enables tick marks to represent compass degrees (see Figure 1-81)

• Clock face – Radio button enables tick marks to represent clock markings (see Figure 1-81)

• AmberJack is upside-down – Enable checkbox only if the AmberJack is mounted in an upside-down 
configuration

• Show Polar Plot – Enable checkbox to display a graphical representation of the RSSI strength measured 
across the 360o (Polar Coordinates) (see Figure 1-82)

Figure 1-78.  Color Selection For RSSI Bar Figure 1-79.  RSSI Bar
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Figure 1-81.  Clock vs. Compass

Figure 1-82.  Compass Active Using Polar Plot

1-12.1.3 Audible RSSI Options

The user has the option to enable/disable sound options by selecting Configure in the Audible RSSI options 
section as shown in Figure 1-73. The Configure DF Audible RSSI dialog opens as shown in Figure 1-83. When 
the sound options are selected as desired, click OK to accept changes and return to the MS DF tab.

Figure 1-83.  Configure DF Audible RSSI
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1-12.2 MS DF OPERATION

The MS DF mode begins as a Registration by attempting to log registrations from iDEN Mobile Stations (MS) that 
are within range of the RayFish system.   During this process the RayFish will register the MS to obtain specific 
IMSI, TMSI, and IMEI information from each MS. 

When an MS' information is received matching the desired subscriber, the mode will change to a Transmit MS DF 
mode. During this time the system will (if applicable) shut down all remaining transmitters except the transmitter 
that has connected to the MS and continue to page the subscriber. The RayFish system will then monitor RSSI 
levels and with the aid of an Amberjack, determine a bearing in the direction of the MS. 

The following procedure describes how to operate the MS DF mode:

Step 1.  Select from 1 to 10 desired subscribers in the subscribers view (use Ctrl + Click to select multiple 
subscribers).

Step 2.  Click the MS DF button ( ) on the iDEN Transceiver toolbar. The Start MS DF dialog will open 
(see Figure 1-84). The subscriber selected in the subscribers view, as well as their identity infor-
mation are listed under the Subscribers tab. The Preferences tab was discussed earlier (see Fig-
ure 1-73). 

Figure 1-84.  Start MS DF Dialog

NOTE
The user also has the ability to start an MS DF from the Channels tab, 
Providers tab, and Neighbor Analysis View results.
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Step 3.  To remove a subscriber, select the row and click the Remove button (use the Ctrl + Click to select 
multiple subscribers).

• Transmit information contains dropdown boxes for PLMN, Provider, Carrier, Color Code, Tx 
Power, and Tx Port

• When the checkbox for Use advanced BTS settings for all transmitters is selected, the 
Configure button becomes available

Step 4.  Select the Configure button to open the Advanced BTS parameters dialog.

Step 5.  Advanced BTS Parameters dialog (see Figure 1-85). Use these parameters (see Table 1-10) to 
emulate a base station. All fields are required. Select the Help button for detailed explanations of 
each field.

Figure 1-85.  Advanced BTS Parameters Dialog  

NOTE
If this mode was started from a tab other then the Subscribers tab, the user 
can click Add... under the Subscriber Information section of the Start MS DF 
dialog and manually add up to 10 subscribers.

NOTE
 The "Transmit on weakest neighbor of selected channels" is only available 
if mode is started from the Channels tab. (Not recommended to disable)

Table 1-10.  Advanced BTS Parameters Description 

Field/Button Explanation

PLMN Public Land Mobile Network (Combination of Mobile Country Code (MCC) 
and Nationwide Direct Connect (NDC) codes

Band Frequency range used for transmission

Carrier Channel/carrier number, listed in hex format
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Step 6.  Edit the fields and select OK to return to the Start MS DF window.

Color Code
An identification affiliated with each channel, making each channel unique. 
Neighboring base stations will have different color code pairs assigned to their 
channels.

Local LAI/LAI1
Local Area Identifier/Local Area Identity 1. The LAI1 is equal to the Local 
LAI and identifies a set of Base Stations within a geographical area. This 
number can range from 1 to 65534.

LAI2
Local Area Identifier/Local Area Identity 2. The LAI2 also identifies a set of 
Base Stations within a geographical area. This number can range from 1 to 
65534.

Cell ID The Cell ID identifies a Base Station within a local area. This number can 
range from 0 to 65535.

SAID Service Area Identifier. The SAID identifies a set of one or more Location 
Areas. This number can range from 0 to 255.

RNC Regional Network Code. This number can range from 0 to (8 * 2^32-1). 
Specify the RNC in hex. It must start with 0x. 

SPC Service Provider Code. This number can range from 0 to (8 * 2^32-1). Specify 
the SPC in hex. It must start with 0x.

Load Loads BTS parameters from a file (if available)

Save As Saves selected BTS parameters (*.abc.iden filename extension)

Defaults Loads default BTS parameters (NOTE: This function will overwrite BTW 
parameters for selected fields)

Help Displays an online help menu that describes the following fields: LAI1, LAI2, 
Cell ID, SAID, RNC, and SPC

Apply to All Apply options to all Carriers/channels in the list

OK Accepts changes and closes the window

Cancel Closes the window without accepting changes

Table 1-10.  Advanced BTS Parameters Description  (Continued)

Field/Button Explanation
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Step 7.  Once the desired subscribers and preferences have been set, click the Start button in the Start 
MS DF dialog.

• The iDEN Transceiver gathers operation information and when complete, if enabled, the user 
will be prompted with the Transmit Validation dialog (see Figure 1-86). 

Figure 1-86.  Transmit Validation

Step 8.  When transmit selections are configured as desired, select Continue to proceed with the MS DF 
operation.      

Figure 1-87.  MS DF Transmit Toolbar With Main Antenna

• To configure the transmit power level, left click the Tx Power button and select the desired 
level from the drop down menu (see Figure 1-88 and Figure 1-89)

• To enable or disable the External PA, click the External PA button (see Figure 1-90)

NOTE
While transmitting, the transmit options buttons are shown on the toolbar for 
on-the-fly configuration of the Transmit Power and External PA (see Figure 
1-87).

Figure 1-88.  Tx Power Button Menu 
(StingRay/KingFish)

Figure 1-89.  Tx Power Button Menu (StingRay II)
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Figure 1-90.  External PA Button

Step 9.  To stop the MS DF operation, select the Stop button located on the toolbar.

1-12.3 MS DF OPERATION RESULTS
• If information matches with a subscriber in the subscribers list, the subscriber tag will reflect the matched 

subscriber

• The subscriber tag may also be highlighted and accompanied by an alert sound, as setup by the user

• Results can be suspended to stop incoming results from scrolling off screen either by selecting the 
Suspend Results button or simply clicking anywhere on the results view. Select Resume Results to 
update with the incoming results (including those that were suspended)

• Subscribers can be added by right-clicking a result, which includes identity information, with results 
suspended 

• The data can be organized by adding or removing columns, moving columns within the display, and sorting 
columns by ascending or descending order

• The results will remain in the results view under the MS DF tab (even if the mode is stopped) until a new 
operation is started or the view is closed normally 

1-12.3.1 Event Summary View

The Event Summary view displays the real-time mobile station registrations (see Figure 1-91 and Table 1-11).

Figure 1-91.  MS DF Event Summary Results

Table 1-11.  MS DF Event Summary Data Columns

Column Example Explanation

Time 10:58:17 AM Date and time the result was surveyed

Provider Nextel Wireless Name of the Service Provider

Band 800 MHz Frequency range utilized for transmission

Carrier 0x469 Radio Frequency Carrier Number

Color Code 4 Base Station Identity
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1-12.3.2 Subscribers Status View

The Subscriber Status view, as shown in a sample results view in Figure 1-92 and Table 1-12, displays the real-
time mobile activity, including the RSSI strength. The Engaged Mobile pane displays identification information and 
a user defined name. The Subscriber Status view (see Figure 1-93) reports the direction and range to the 
subscriber mobile.

Figure 1-92.  MS DF Subscriber Status

Event type Location Update A sequence of messages from a mobile identified as a certain event

Subscriber Tag Blue Tag Name of Subscriber

TMSI A0C9F97F Temporary Mobile Subscriber Identity

IMSI 31601... International Mobile Subscriber Identity

IMEI 00170... International Mobile Equipment Identity

RSSI -80 Received Signal Strength Indicator of the forward link in dBm

SQE 14 Signal Quality Value 

NOTE
StingRay II accepts and will search on multiple subscribers, but locks onto the 
first one it finds.

Table 1-12.  MS DF Subscriber Status Results Data Columns

Column Example Explanation

Subscriber Tag Green Boy Name of subscriber

Status Connected Indicates current subscriber status

Table 1-11.  MS DF Event Summary Data Columns (Continued)

Column Example Explanation
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Figure 1-93.  MS DF Subscriber Status With AmberJack

RSSI -82 Relative Signal Strength Indicator

SQE 20 Signal Quality Value

Range (m) 350 Estimated distance to the subscriber (in meters)

Table 1-12.  MS DF Subscriber Status Results Data Columns (Continued)

Column Example Explanation
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1-13 HELP

The iDEN Controller Help menu provides the user with quick access to system information via the About window’s 
Details screen.

To view About window, select About from the Help menu (see Figure 1-94). The About window will open (see 
Figure 1-95). Select the Details... button to display the system details screen (see Figure 1-96). This information 
will be useful whenever a user places a service call. The About details dialog contains the current PC Version 
number. The SDR Information area contains the protocol firmware and corresponding version that are loaded on 
each SDR.

Figure 1-94.  Help Menu

Figure 1-95.  About Dialog

Figure 1-96.  About Screen Details (StingRay I) 
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2-1 WHAT THIS CHAPTER CONTAINS

This chapter contains tools available to the iDEN Transceiver user. 

• Database Viewer (see Paragraph 2-2) - The Database Viewer allows the viewing of stored data

• Map Router (see Paragraph 2-3) - The Map Router provides the interface between the iDEN Transceiver 
and MapPoint

• Perform Self-Test (see Paragraph 2-11) - This tool commands the SDRs to initialize and confirms 
accurate hardware functionality

• Advanced BTS Editor (see Paragraph 2-12) - The iDEN Transceiver 

• Night Mode Display Options (see Paragraph 2-13) - The iDEN Transceiver installs two Windows display 
themes (Gray Night Theme and Green Night Theme) to support reduced light emissions from the user 
interface display

• Analyze Neighbors Feature   (see Paragraph 2-14) - This feature identifies transmit channels within the 
area of interest for Registration and MS DF operations 

2-2 DATABASE VIEWER

The iDEN Transceiver provides the user with the Database Viewer tool for viewing stored data. The user can either 
launch the Database Viewer from the Windows Start menu (Start>Programs>iDEN Transceiver >Database 
Viewer) from the PC desktop or through the Tools menu within the iDEN Transceiver. The Database Viewer will 
open as a second application window (see Figure 2-1). Opening the Database Viewer from the iDEN Transceiver 
will open the current database.

Figure 2-1.  Database Viewer Main Window

Chapter

2 TOOLS
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Data may be displayed by Session Tag in the Data Results view in the Database Viewer as shown in Figure 2-2.

Figure 2-2.  Data by Session Tag View

2-2.1 OPEN DATABASE

The following procedure describes how to open a saved database.

Step 1.  Select Open Database from the File menu (see Figure 2-3) or click the Open icon on the toolbar 
(see Figure 2-4).

Step 2.  From the Open dialog (see Figure 2-5), select the desired database file to load and click the Open 
button. The database will load in the Database Viewer (see Figure 2-1).

Figure 2-3.  File > Open Database Figure 2-4.  Open Icon
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Figure 2-5.  Open Database

2-2.2 CLOSE DATABASE

The following procedure describes how to close a database. 

Step 1.  With a database opened in the Database Viewer, select the File menu.

Step 2.  Select Close Database (see Figure 2-6).

Figure 2-6.  File > Close Database

2-2.3 EXPORT DATA

The following procedure describes how to export data. By default, the Export Data exports the entire table view to 
the chosen data file.

Step 1.  Select one or more rows from the Database Viewer (see Figure 2-7) to export a portion of the 
table.
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Figure 2-7.  Multiple Rows Selected

Step 2.   Select the File menu and Export Data (see Figure 2-8) or the Export icon from the toolbar 
(see Figure 2-9). 

NOTE
Press Shift+left mouse click to select sequential rows in the Database
Viewer.
Press Ctrl+left mouse click to select non-sequential rows in the
Database Viewer ().
Press Ctrl+A to select all rows in the Database Viewer.

Figure 2-8.  File > Export Data Figure 2-9.  Export Icon
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• The Export Data dialog will open (see Figure 2-10)

Figure 2-10.  Export Data Options

The Export Options area contains the three options for the export file type.

• Export to CSV File – Exports the currently open view (table) to a comma separated value file format. The 
CSV files are useful for exchanging data where the tools that will be used to view the data are unknown

• Export to Excel – Exports the currently open view to the MS Excel application and opens the file in MS 
Excel. This feature is only supported if MS Excel is already installed on the computer. Excel will open 
automatically to allow viewing of the data

• Export to KML – Exports the currently open view to a KML file. KML files are useful for viewing geographic 
relationships. This option is grayed out unless the view contains Latitude and Longitude fields

Step 3.  Click the radio button in front of the file type you want to create.

Step 4.  Select the checkbox to Export selected rows only.

Step 5.  Click Next button.

The Export Data window opens to choose the location to save the file. Since the CSV file choice was made in the 
example, the CSV Export Options dialog appears (see Figure 2-11). The two checkbox selections are described 
below:

• Include application and view information – This adds a line with the database type and version number 
to the beginning of the CSV file

• Include header row – This adds a header row at the beginning of the CSV file
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Figure 2-11.  Export Data Options 2

Step 6.  Select the BROWSE button (see Figure 2-11) to open the Save As dialog (see Figure 2-12).

Figure 2-12.  Save as Dialog

Step 7.  Navigate to the location to save the exported file.

Step 8.   Type the filename desired and click Save. 

Step 9.  Click the Finish button to complete exporting the data.

2-2.4 VIEW DATA

Data logged and stored by the iDEN Transceiver can be loaded and viewed in the Database Viewer. The Database 
Viewer organizes the data in the Data Views pane by operational mode.
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2-2.4.1 Data Views

The Data Views pane organizes the data by operational mode (see Figure 2-13). To view data, select the All 
Results under the desired mode.

Figure 2-13.  Data Views Pane



RayFish Product Family Manual

Tools Chapter 2

2-8

HARRIS PROPRIETARY / USC TITLE 18 WARNING: EXPORT-CONTROLLED DOCUMENT

2-2.4.2 Filters

The Database Viewer allows and recommends that the user configure filters on large sets of data. The Configure 
Filters dialog (see Figure 2-14) will open automatically when a large set of data has been selected for viewing. The 
dialog can also be opened using the Filter icon on the toolbar (see Figure 2-15). 

Figure 2-14.  Configure Filters – Field Selection

 

Figure 2-15.  Filter Icon

The following procedure describes how to filter data.

Step 1.  If the Configure Filters window doesn’t open automatically, select the desired results to be filtered 
within the Data Views panel and then click the Filter icon (see Figure 2-15).

Step 2.  Select the Field drop down (see Figure 2-14) to specify the field on which to filter.
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Step 3.  Select the Comparator drop down (see Figure 2-16) to specify the comparison to apply to the 
selected Field option.

Figure 2-16.  Configure Filters – Comparator Selection

Step 4.  Select the method to enter the item being compared against (see Figure 2-16). 

• The Default option will set the method for entering the item being compared against with the 
default control in relation to the Field option selected.  For example, if the Field option 
selected is Provider, the Default option will allow the user to enter a text string 

• The Text–only option will override the default method for the chosen Field and only allow the 
user to enter a text string  

• The Match Field option will allow the user to pick another Field to compare against the first 
Field chosen using the Comparator  

Step 5.  Click the Add button to add the filter to the Filters: area (see Figure 2-17). 

Figure 2-17.  Configure Filters – Add Button
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• Repeat steps 2 through 5 to add multiple filters. For example, one may wish to view Auto Sur-
vey data logged on a certain date and for a certain provider, but only with an average RSSI 
greater than -100 (see Figure 2-18)

Figure 2-18.  Configure Filters Window Configuring Multiple Filters

Step 6.  Once the desired filters have been added to the Filters: area, the user can configure them 
as desired:

• Select a filter from the Filters: area and click the Edit button to re-populate the drop down 
controls with the chosen filter. The user can edit the filter and click Save to update or click 
Cancel to leave the filter unchanged

• Select a filter from the Filters: area and click the Delete button to remove that filter from the 
Configure Filters window 

• The Clear button removes all defined filters from the Configure Filters window 

Step 7.  Right-click on a filter and select Create Group to create a new group with the chosen filter 
(see Figure 2-19). 

• By right clicking on a group, the user can toggle the entire group between Match All and 
Match Any.  Match All will only display results which match all the filters in the group.  Match 
Any will show all results that match any of the filters in the group

• Toggle negation toggles the Comparator portion of the filter to the exact opposite. For exam-
ple, if Toggle negation is chosen on a Filter with the Comparator "Equal To" it will be toggled 
to "Not Equal To" 

• The Edit and Delete options in the right-click menu perform the same function as the Edit and 
Delete buttons on the Configure Filters window

• Filters can be dragged and dropped into other groups. Select and hold a filter and move it over 
the desired group in the Filters: area
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Figure 2-19.  Configure Filters Window – Right-Click Menu

Step 8.  Once the desired filters have been configured in the Configure Filters window select the OK button 
to apply the filter. Selecting the Cancel button will exit the Configure Filters window without apply-
ing filters and all available results will be displayed.

2-2.5 EDIT MENU

The Database Edit menu provides the user an alternate path to configure database properties from within the 
Database Viewer application (see Figure 2-20). 

Figure 2-20.  Edit Menu

•  A Search option has been added to the Database Viewer Edit menu. When selected, it opens the Find 
bar at the bottom (see Figure 2-21)

Figure 2-21.  Find Bar

• Enter the Search data in the Find field 
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• Select the Next arrow to locate the next occurrence of that data or the Previous arrow to scroll up and find 
the previous entry for the data

• Select the Orange X to close the Find Bar

2-2.6 ABOUT DATABASE VIEWER

The About Database Viewer dialog provides version information. To open the dialog, from the Database Viewer 
window, select the Help menu from the toolbar or the Help icon as shown in Figure 2-22. 

Figure 2-22.  About Database Viewer
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2-3 CONFIGURE MAP ROUTER

Map Router is an application that is installed in addition to the iDEN Controller. This chapter covers the following 
topics:

• Map Router Overview 

• Connecting Map Router to iDEN

• Map Router Setup 

• Map Router Main Functions

• Multiple Location Finding Estimate

• Geographic Filter

• Multi-Playback File Support

2-4 MAP ROUTER OVERVIEW

When the iDEN Controller is installed, it also installs Map Router and creates a Map Router icon on the Windows 
Desktop. Map Router is configured to run in the background when installation completes and when the PC is 
restarted. The Windows Task bar Notification area located in the lower right corner of the desktop will display Map 
Router icon when the application is running as shown in the Figure 2-23. 

Figure 2-23.  Map Router Icons

Map Router provides an interface between the iDEN application and MapPoint. When setting up Map Router to 
communicate with MapPoint, ensure that MapPoint is properly displaying the COM add in.  Map Router now 
automatically configures the MapPoint COM add in.
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2-5 CONNECTING MAP ROUTER TO IDEN

This section describes settings to configure the iDEN Controller’s connections to Map Router tool. When the 
connection is activated, all data is passed to Map Router.

• To open Map Router Configuration window, select Configure Map Router from the Tools menu

• To configure Map Router to automatically connect on startup, select the Connect to Map Router on 
startup check box as shown in the Figure 2-24

• To manually initiate the connection, select the Connect button

Figure 2-24.  Configure Map Router

• Select Close to close the dialog

If there is a need to switch the Host IP Address and/or Port setting, Map Router application will also need to be 
configured with the same Host IP and/or Port settings.

NOTE
The default Port value is the same default Port value used by Map 
Router.
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2-6 SETUP

The following procedure describes how to setup, configure and use Map Router:

Step 1.  Launch Map Router by selecting the icon from the desktop or the Windows Task bar Notification Area. 
Map Router Main window displays as shown in the Figure 2-25.

Figure 2-25.  Map Router Main Window

•    The Menu bar at the top of the window displays File, Edit, Tools, and Help menus
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Figure 2-26.  Map Router Edit Preferences

Step 2.  Use the Menu bar to Edit Preferences, clear the KML file, display version information, and to exit Map 
Router.

• File – Contains the Close choice to exit Map Router

• Edit – Contains the Edit Preferences options to configure Map Router as shown in the Figure 2-
26 and Clear KML File

• Tools – Contains the Geographic Boundaries options

• Help – Displays the About option (containing the version and copyright date)

2-7 MAIN WINDOW FUNCTIONS

Map Router Main window has the following five separate functional areas in addition to the Menu Bar:

1.  Playback – This area is used to play back a prerecorded route as shown in the Figure 2-27

2.  Record – Provides the Start and Stop buttons for the Record function

Figure 2-27.  Map Router Playback and Record

3.  Input – Data can be from the current network file or the user can choose to load an existing saved file. 
Selecting the Edit Input button as shown in the Figure 2-28) displays the Edit Input dialog
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Figure 2-28.  Map Router Input

4.  Select the Playback File radio button and click the Browse button as shown in the Figure 2-29

Figure 2-29.  Edit Input Dialog

•    To load an existing saved file, select the Playback File radio button, click Browse, navigate to 
the desired saved file, select Open and the OK button

5.  Display Location Configuration button as shown in the Figure 2-30 – From Map Router main window, 
select this button to display the Location Information dialog
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Figure 2-30.  Display Location Information and Output

•    The Name and Status is displayed during an MS DF operation

•    The Name will display the active subscriber selected for the MS DF operation

•    The Status field will display N/A, Connected, or Lost

6.  Output 

•    Output may be saved to a maximum of four network file connections

•    When Map Router displays one designated address, the Add Output button is activated

• Selecting the Add Output button opens the Add Output Connection dialog as shown in the Fig-
ure 2-31

Figure 2-31.  Add Output Connection Dialog

•    Select an output Name from the drop down Name list

•    Designating two connections on Map Router main window, activates the Edit Output and 
Remove Output buttons
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•    The Edit Output option allows the editing of the Connection’s Name, IP Address, and Port

•    Selecting the Remove Output button from Map Router main window, immediately deletes the 
highlighted connection

7.  Google Earth – Google Earth is a virtual globe with maps and geographical data

• This is a Commercial Off-the-Shelf (COTS) product

• This application must be downloaded and installed separately

• This downloadable application can be located at http://earth.google.com/

2-8 MULTIPLE LOCATION FINDING ESTIMATE

Map Router is capable of calculating Location Finding estimates for multiple subscribers. Current Location Finding 
estimates for each enabled subscriber are sent to all enabled map outputs. Results for all subscribers are retained 
until the results are manually changed or the input to Map Router is changed. Results are manually cleared using 
the Clear Data button in the Location Information dialog as shown in the Figure 2-32.

Figure 2-32.  Clear Data and Edit Input
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2-9 GEOGRAPHIC FILTER

The Geo-Filter as shown in the Figure 2-33 allows users to define a Geographic boundary. This boundary can be 
used to limit Location Finding solution outputs to only those falling inside of that region. The Geo-Filter can be 
applied in real time or during post-processing using Map Router playback files. 

Figure 2-33.  Enable Geo-Filter

2-10 MULTI-PLAYBACK FILE SUPPORT

Map Router supports combining multiple playback files into a single playback file.

To combine multiple Map Router playbacks into a single multi-playback file:

Step 1.  Select the Edit Input button, as shown in the Figure 2-32.

Step 2.  From the Edit Input dialog, select Playback File radio button.

Step 3.  Browse to the location where your playback files are located (they must all be in the same folder).

Step 4.  Then select all of the files that are to be combined by holding the CNTRL or Shift key and selecting 
each file.

• When all of the desired files are selected, select the Open button

• The Multi-Playback file will be automatically loaded and ready for playback

• The files will be combined into a single Multi-Playback file (*.mpb) and saved in the same working 
directory
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2-11 PERFORM SELF-TEST

The Perform Self-Test action commands the SDRs to initialize and confirms hardware functionality. 

• From the Main menu, select Tools > Perform Self-Test 

• The Self-Test Results dialog displays the SDRs tab (see Figure 2-34 and Figure 2-35)

Figure 2-34.  SDRs Self-Test Results (StingRay/KingFish)

Figure 2-35.  SDRs Self-Test Results (StingRay II)

• RFM – Radio Frequency Module (StingRay II) (see Figure 2-36)
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• SyBIR – Manages communication between the SDRs and provides chassis status (StingRay II) 
(see Figure 2-37)

• Select the Close button to return to the Main window

Figure 2-36.  RFM Self-Test (StingRay II) Figure 2-37.  SyBIR Self-Test (StingRay II)
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2-12 ADVANCED BTS EDITOR

The Advanced BTS Editor emulates a Base Transceiver Station based on user-defined field parameters. 

• From the Main menu, select Tools > Advanced BTS Editor 

• The Advanced BTS Editor dialog box displays (see Figure 2-38). From here, the user can configure 
specific transmitted parameters to increase the flexibility of transmit modes. Detailed descriptions were 
presented previously in Paragraph 1-11.2 and Paragraph 1-12.2

Figure 2-38.  Advanced BTS Editor Dialog Box
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2-13 NIGHT MODE DISPLAY OPTIONS 

The iDEN Transceiver installs two Windows display themes (Gray Night Theme and Green Night Theme) to 
support reduced light emissions from the user interface display.

Step 1.  To utilize a Night Mode Windows theme, Right Click on the desktop to bring up the Desktop 
Menu (see Figure 2-39).

Figure 2-39.  Desktop Menu

Step 2.  Select Properties to open the Display Properties screen with the Themes tab 
active (see Figure 2-40).

Figure 2-40.  Display Properties Screen
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Step 3.  Scroll to and select the Gray Night Theme (see Figure 2-41) or the Green Night Theme 
(see Figure 2-42). 

A sample Main Screen using the Gray Night Theme is shown in Figure 2-43. 

Figure 2-41.  Gray Night Theme Figure 2-42.  Green Night Theme
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Figure 2-43.  Gray Night Theme - Main Screen
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2-14 ANALYZE NEIGHBORS FEATURE

The iDEN Transceiver provides a feature for identifying transmit channels within the area of interest for 
Registration and MS DF operations.

Step 1.  To Analyze Neighbors, select the chosen channels and right click to display the 
pop-up (see Figure 2-44).

Figure 2-44.  Analyze Neighbors

Step 2.  Select Analyze Neighbors from the pop-up and the results are displayed in the Neighbor 
Analysis View (see Figure 2-45 and Table 2-1). 

• Neighbor analysis shows the neighbor channel commonality for the channels specified in the 
Channels view

• The RSSI will be displayed for any base station neighbors that were decoded during Survey
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Figure 2-45.  Neighbor Analysis Results

The user may run an Registration or MS DF operation from the Neighbor Analysis View.

Table 2-1.  Neighbor Analysis Results Data Columns

Column Example Explanation

Neighbor 0x33F - F A neighbor of the highlighted channels

Commonality 33% The percentage of the highlighted channels where the neighbor 
is included on the neighbor list

Surveyed RSSI -97 The RSSI of the surveyed neighbor. No measurement indicates 
the neighbor was not surveyed

Cell IDs 6387 The cell ID for the highlighted channel where the neighbor is on 
the neighbor list
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A-1 WHAT THIS APPENDIX CONTAINS

This appendix contains terms and definitions found in the iDEN Transceiver software. We depend on customer 
input to continuously add and update this section.

A

Access Channel - A Reverse iDEN Channel used by 
mobile stations for communicating to the Base Station. 
The Access Channel is used for short signaling 
message exchanges such as call originations, 
responses to pages, and registrations. The Access 
Channel is a slotted random access channel

Authentication (Auth) - A procedure used by a base 
station to validate a mobile station's identity

Analyze Neighbors - A tool for identifying transmit 
channels for Registration of MS DF

B

Base Class - A set of frequency channels and a 
numbering scheme for these channels. Cellular and 
PCS Base Classes are 0 and 1, respectively

BTS - Base Transceiver Station

 C

Color Code - An identification affiliated with each 
channel, making each channel unique. Neighboring 
base stations will have different color code pairs 
assigned to their channels

iDEN Channel - The set of channels transmitted 
between the base station and the mobile stations within 
a given iDEN frequency assignment 

Cell ID - Base Station identity within a local area

Code Channel - A sub channel of a Forward iDEN 
Channel. A Forward iDEN Channel contains 64 code 
channels. Code channels 1 through 7 may be assigned 
to the either Paging Channels or the Traffic Channels. 
Code channel 32 may be assigned to either a Sync 
Channel or a Traffic Channel. The remaining code 
channels may be assigned to Traffic Channels

D

DF - Direction Finding

dBm - Decibels above or below one milliwatt. Used to 
indicate receive signal strength

E

Event - An over-the-air cellular transaction from which  
logs Signal Related Information (SRI)

External PA -  accessory that is used to boost the 
transmit power

I

IMEI - International Mobile Equipment Identity (IMEI)- 
64-bit binary value that is programmed into the mobile 
telephone at time of manufacture. It includes serial 
number, country of production, and type approval

IMSI - See International Mobile Subscriber Identity.

International Mobile Subscriber Identity (IMSI) - A 
method of identifying stations in the land mobile service 
as specified in CCITT Recommendation E.212

Registration - An operational mode in which  emulates 
a base station, forcing registrations from mobile 
phones to log identifying information

L

LAI - Location Area Identifier

M

MCC - Mobile Country Code

MS - Mobile Station (cell phone)

Mobile Base Station Survey - A series of Base 
Station Surveys that performs at user-defined intervals

Appendix

A TERMS AND DEFINITIONS
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N

Neighbor List - A list of neighbor PLMNs that a base 
station transmits to mobile phones to assist in handoff 
operations

Network Identification (NID) - A number that uniquely 
identifies a network within a cellular or PCS system. 
See also System Identification

NDC - Nationwide Direct Connect

P

Paging - The act of seeking a mobile station when a 
call has been placed to that mobile station

PCC - Personal Computer Controller

PLMN - Public Land Mobile Network (Combination of 
the MCC & NDC)

Provider - Cellular service provider

R

Registration - The process by which a mobile station 
identifies its location and parameters to a base station

Reverse iDEN Channel - A iDEN Channel from the 
mobile station to the base station that includes Access 
Channel(s) and Traffic Channels. Resync - A process 
by which performs a Base Station Survey to 
resynchronize with network timing

RFM - Radio Frequency Module

RNC - Regional Network Code

RSSI - Received Signal Strength Indicator, a measure 
of RF channel power expressed in dB

S

SAID - Service Area Identifier

SID - See System Identification

SPC - Service Provider Code

SQE - Signal Quality Estimate

Survey - See Base Station Survey

Survey Interval - The user-selected interval at which  
performs Base Station Surveys

Survey Type - The option used to perform a Base 
Station Survey (Stationary or Mobile)

SyBIR - Manages the communication between the 
SDRs and provides chassis status

Sync Channel - A code channel in a Forward iDEN 
Channel that transports the Synchronization Message 
to the mobile station

System - A block of iDEN Channels (a or b for cellular 
band; A, B, C, D, E, or F for PCS Band)

System Identification (SID) - A number uniquely 
identifying a cellular or PCS system

System Time - Current value of iDEN system time 
provided on the Sync Channel.

T

Tag - The name assigned to a subscribers phone

Subscriber - The subject of the operation identified by 
his/her mobile phone Min or ESN or by a Dialed 
Number

Transmit DF - Direction Finding technique that 
Transmits to an idle mobile phone (does not require the 
subscriber phone to be engaged in a call)

TX Power - Amount of RF power being transmitted in 
the MOBILE Transceiver mode. Options available are 0 
to 24 dBm in 3 dB increments

V

VSWR - Voltage Standing Wave Ratio
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B-1 iDEN FREQUENCY TABLES

Table B-1 contains channels (carriers) and frequencies for the iDEN 800 MHz band.

Appendix

B FREQUENCY TABLES

Table B-1.  iDEN Frequency Table

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)

0 0X000 806.0000 851.0000

1 0X001 806.0125 851.0125 

2 0X002 806.0250 851.0250 

3 0X003 806.0375 851.0375 

4 0X004 806.0500 851.0500 

5 0X005 806.0625 851.0625 

6 0X006 806.0750 851.0750 

7 0X007 806.0875 851.0875 

8 0X008 806.1000 851.1000 

9 0X009 806.1125 851.1125 

10 0X00A 806.1250 851.1250 

11 0X00B 806.1375 851.1375 

12 0X00C 806.1500 851.1500 

13 0X00D 806.1625 851.1625 

14 0X00E 806.1750 851.1750 

15 0X00F 806.1875 851.1875 

16 0X010 806.2000 851.2000 

17 0X011 806.2125 851.2125 

18 0X012 806.2250 851.2250 

19 0X013 806.2375 851.2375 

20 0X014 806.2500 851.2500 

21 0X015 806.2625 851.2625 
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22 0X016 806.2750 851.2750 

23 0X017 806.2875 851.2875 

24 0X018 806.3000 851.3000 

25 0X019 806.3125 851.3125 

26 0X01A 806.3250 851.3250 

27 0X01B 806.3375 851.3375 

28 0X01C 806.3500 851.3500 

29 0X01D 806.3625 851.3625 

30 0X01E 806.3750 851.3750 

31 0X01F 806.3875 851.3875 

32 0X020 806.4000 851.4000 

33 0X021 806.4125 851.4125 

34 0X022 806.4250 851.4250 

35 0X023 806.4375 851.4375 

36 0X024 806.4500 851.4500 

37 0X025 806.4625 851.4625 

38 0X026 806.4750 851.4750 

39 0X027 806.4875 851.4875 

40 0X028 806.5000 851.5000 

41 0X029 806.5125 851.5125 

42 0X02A 806.5250 851.5250 

43 0X02B 806.5375 851.5375 

44 0X02C 806.5500 851.5500 

45 0X02D 806.5625 851.5625 

46 0X02E 806.5750 851.5750 

47 0X02F 806.5875 851.5875 

48 0X030 806.6000 851.6000 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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49 0X031 806.6125 851.6125 

50 0X032 806.6250 851.6250 

51 0X033 806.6375 851.6375 

52 0X034 806.6500 851.6500 

53 0X035 806.6625 851.6625 

54 0X036 806.6750 851.6750 

55 0X037 806.6875 851.6875 

56 0X038 806.7000 851.7000 

57 0X039 806.7125 851.7125 

58 0X03A 806.7250 851.7250 

59 0X03B 806.7375 851.7375 

60 0X03C 806.7500 851.7500 

61 0X03D 806.7625 851.7625 

62 0X03E 806.7750 851.7750 

63 0X03F 806.7875 851.7875 

64 0X040 806.8000 851.8000 

65 0X041 806.8125 851.8125 

66 0X042 806.8250 851.8250 

67 0X043 806.8375 851.8375 

68 0X044 806.8500 851.8500 

69 0X045 806.8625 851.8625 

70 0X046 806.8750 851.8750 

71 0X047 806.8875 851.8875 

72 0X048 806.9000 851.9000 

73 0X049 806.9125 851.9125 

74 0X04A 806.9250 851.9250 

75 0X04B 806.9375 851.9375 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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76 0X04C 806.9500 851.9500 

77 0X04D 806.9625 851.9625 

78 0X04E 806.9750 851.9750 

79 0X04F 806.9875 851.9875 

80 0X050 807.0000 852.0000 

81 0X051 807.0125 852.0125 

82 0X052 807.0250 852.0250 

83 0X053 807.0375 852.0375 

84 0X054 807.0500 852.0500 

85 0X055 807.0625 852.0625 

86 0X056 807.0750 852.0750 

87 0X057 807.0875 852.0875 

88 0X058 807.1000 852.1000 

89 0X059 807.1125 852.1125 

90 0X05A 807.1250 852.1250 

91 0X05B 807.1375 852.1375 

92 0X05C 807.1500 852.1500 

93 0X05D 807.1625 852.1625 

94 0X05E 807.1750 852.1750 

95 0X05F 807.1875 852.1875 

96 0X060 807.2000 852.2000 

97 0X061 807.2125 852.2125 

98 0X062 807.2250 852.2250 

99 0X063 807.2375 852.2375 

100 0X064 807.2500 852.2500 

101 0X065 807.2625 852.2625 

102 0X066 807.2750 852.2750 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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103 0X067 807.2875 852.2875 

104 0X068 807.3000 852.3000 

105 0X069 807.3125 852.3125 

106 0X06A 807.3250 852.3250 

107 0X06B 807.3375 852.3375 

108 0X06C 807.3500 852.3500 

109 0X06D 807.3625 852.3625 

110 0X06E 807.3750 852.3750 

111 0X06F 807.3875 852.3875 

112 0X070 807.4000 852.4000 

113 0X071 807.4125 852.4125 

114 0X072 807.4250 852.4250 

115 0X073 807.4375 852.4375 

116 0X074 807.4500 852.4500 

117 0X075 807.4625 852.4625 

118 0X076 807.4750 852.4750 

119 0X077 807.4875 852.4875 

120 0X078 807.5000 852.5000 

121 0X079 807.5125 852.5125 

122 0X07A 807.5250 852.5250 

123 0X07B 807.5375 852.5375 

124 0X07C 807.5500 852.5500 

125 0X07D 807.5625 852.5625 

126 0X07E 807.5750 852.5750 

127 0X07F 807.5875 852.5875 

128 0X080 807.6000 852.6000 

129 0X081 807.6125 852.6125 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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130 0X082 807.6250 852.6250 

131 0X083 807.6375 852.6375 

132 0X084 807.6500 852.6500 

133 0X085 807.6625 852.6625 

134 0X086 807.6750 852.6750 

135 0X087 807.6875 852.6875 

136 0X088 807.7000 852.7000 

137 0X089 807.7125 852.7125 

138 0X08A 807.7250 852.7250 

139 0X08B 807.7375 852.7375 

140 0X08C 807.7500 852.7500 

141 0X08D 807.7625 852.7625 

142 0X08E 807.7750 852.7750 

143 0X08F 807.7875 852.7875 

144 0X090 807.8000 852.8000 

145 0X091 807.8125 852.8125 

146 0X092 807.8250 852.8250 

147 0X093 807.8375 852.8375 

148 0X094 807.8500 852.8500 

149 0X095 807.8625 852.8625 

150 0X096 807.8750 852.8750 

151 0X097 807.8875 852.8875 

152 0X098 807.9000 852.9000 

153 0X099 807.9125 852.9125 

154 0X09A 807.9250 852.9250 

155 0X09B 807.9375 852.9375 

156 0X09C 807.9500 852.9500 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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157 0X09D 807.9625 852.9625 

158 0X09E 807.9750 852.9750 

159 0X09F 807.9875 852.9875 

160 0X0A0 808.0000 853.0000 

161 0X0A1 808.0125 853.0125 

162 0X0A2 808.0250 853.0250 

163 0X0A3 808.0375 853.0375 

164 0X0A4 808.0500 853.0500 

165 0X0A5 808.0625 853.0625 

166 0X0A6 808.0750 853.0750 

167 0X0A7 808.0875 853.0875 

168 0X0A8 808.1000 853.1000 

169 0X0A9 808.1125 853.1125 

170 0X0AA 808.1250 853.1250 

171 0X0AB 808.1375 853.1375 

172 0X0AC 808.1500 853.1500 

173 0X0AD 808.1625 853.1625 

174 0X0AE 808.1750 853.1750 

175 0X0AF 808.1875 853.1875 

176 0X0B0 808.2000 853.2000 

177 0X0B1 808.2125 853.2125 

178 0X0B2 808.2250 853.2250 

179 0X0B3 808.2375 853.2375 

180 0X0B4 808.2500 853.2500 

181 0X0B5 808.2625 853.2625 

182 0X0B6 808.2750 853.2750 

183 0X0B7 808.2875 853.2875 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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184 0X0B8 808.3000 853.3000 

185 0X0B9 808.3125 853.3125 

186 0X0BA 808.3250 853.3250 

187 0X0BB 808.3375 853.3375 

188 0X0BC 808.3500 853.3500 

189 0X0BD 808.3625 853.3625 

190 0X0BE 808.3750 853.3750 

191 0X0BF 808.3875 853.3875 

192 0X0C0 808.4000 853.4000 

193 0X0C1 808.4125 853.4125 

194 0X0C2 808.4250 853.4250 

195 0X0C3 808.4375 853.4375 

196 0X0C4 808.4500 853.4500 

197 0X0C5 808.4625 853.4625 

198 0X0C6 808.4750 853.4750 

199 0X0C7 808.4875 853.4875 

200 0X0C8 808.5000 853.5000 

201 0X0C9 808.5125 853.5125 

202 0X0CA 808.5250 853.5250 

203 0X0CB 808.5375 853.5375 

204 0X0CC 808.5500 853.5500 

205 0X0CD 808.5625 853.5625 

206 0X0CE 808.5750 853.5750 

207 0X0CF 808.5875 853.5875 

208 0X0D0 808.6000 853.6000 

209 0X0D1 808.6125 853.6125 

210 0X0D2 808.6250 853.6250 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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211 0X0D3 808.6375 853.6375 

212 0X0D4 808.6500 853.6500 

213 0X0D5 808.6625 853.6625 

214 0X0D6 808.6750 853.6750 

215 0X0D7 808.6875 853.6875 

216 0X0D8 808.7000 853.7000 

217 0X0D9 808.7125 853.7125 

218 0X0DA 808.7250 853.7250 

219 0X0DB 808.7375 853.7375 

220 0X0DC 808.7500 853.7500 

221 0X0DD 808.7625 853.7625 

222 0X0DE 808.7750 853.7750 

223 0X0DF 808.7875 853.7875 

224 0X0E0 808.8000 853.8000 

225 0X0E1 808.8125 853.8125 

226 0X0E2 808.8250 853.8250 

227 0X0E3 808.8375 853.8375 

228 0X0E4 808.8500 853.8500 

229 0X0E5 808.8625 853.8625 

230 0X0E6 808.8750 853.8750 

231 0X0E7 808.8875 853.8875 

232 0X0E8 808.9000 853.9000

233 0X0E9 808.9125 853.9125 

234 0X0EA 808.9250 853.9250 

235 0X0EB 808.9375 853.9375 

236 0X0EC 808.9500 853.9500 

237 0X0ED 808.9625 853.9625 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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238 0X0EE 808.9750 853.9750 

239 0X0EF 808.9875 853.9875 

240 0X0F0 809.0000 854.0000 

241 0X0F1 809.0125 854.0125 

242 0X0F2 809.0250 854.0250 

243 0X0F3 809.0375 854.0375 

244 0X0F4 809.0500 854.0500 

245 0X0F5 809.0625 854.0625 

246 0X0F6 809.0750 854.0750 

247 0X0F7 809.0875 854.0875 

248 0X0F8 809.1000 854.1000 

249 0X0F9 809.1125 854.1125 

250 0X0FA 809.1250 854.1250 

251 0X0FB 809.1375 854.1375 

252 0X0FC 809.1500 854.1500 

253 0X0FD 809.1625 854.1625 

254 0X0FE 809.1750 854.1750 

255 0X0FF 809.1875 854.1875 

256 0X100 809.2000 854.2000 

257 0X101 809.2125 854.2125 

258 0X102 809.2250 854.2250 

259 0X103 809.2375 854.2375 

260 0X104 809.2500 854.2500 

261 0X105 809.2625 854.2625 

262 0X106 809.2750 854.2750 

263 0X107 809.2875 854.2875 

264 0X108 809.3000 854.3000 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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265 0X109 809.3125 854.3125 

266 0X10A 809.3250 854.3250 

267 0X10B 809.3375 854.3375 

268 0X10C 809.3500 854.3500 

269 0X10D 809.3625 854.3625 

270 0X10E 809.3750 854.3750 

271 0X10F 809.3875 854.3875 

272 0X110 809.4000 854.4000 

273 0X111 809.4125 854.4125 

274 0X112 809.4250 854.4250 

275 0X113 809.4375 854.4375 

276 0X114 809.4500 854.4500 

277 0X115 809.4625 854.4625 

278 0X116 809.4750 854.4750 

279 0X117 809.4875 854.4875 

280 0X118 809.5000 854.5000 

281 0X119 809.5125 854.5125 

282 0X11A 809.5250 854.5250 

283 0X11B 809.5375 854.5375 

284 0X11C 809.5500 854.5500 

285 0X11D 809.5625 854.5625 

286 0X11E 809.5750 854.5750 

287 0X11F 809.5875 854.5875 

288 0X120 809.6000 854.6000 

289 0X121 809.6125 854.6125 

290 0X122 809.6250 854.6250 

291 0X123 809.6375 854.6375 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)
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292 0X124 809.6500 854.6500 

293 0X125 809.6625 854.6625 

294 0X126 809.6750 854.6750 

295 0X127 809.6875 854.6875 

296 0X128 809.7000 854.7000 

297 0X129 809.7125 854.7125 

298 0X12A 809.7250 854.7250 

299 0X12B 809.7375 854.7375 

300 0X12C 809.7500 854.7500 

301 0X12D 809.7625 854.7625 

302 0X12E 809.7750 854.7750 

303 0X12F 809.7875 854.7875 

304 0X130 809.8000 854.8000 

305 0X131 809.8125 854.8125 

306 0X132 809.8250 854.8250 

307 0X133 809.8375 854.8375 

308 0X134 809.8500 854.8500 

309 0X135 809.8625 854.8625 

310 0X136 809.8750 854.8750 

311 0X137 809.8875 854.8875 

312 0X138 809.9000 854.9000 

313 0X139 809.9125 854.9125 

314 0X13A 809.9250 854.9250 

315 0X13B 809.9375 854.9375 

316 0X13C 809.9500 854.9500 

317 0X13D 809.9625 854.9625 

318 0X13E 809.9750 854.9750 
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319 0X13F 809.9875 854.9875 

320 0X140 810.0000 855.0000 

321 0X141 810.0125 855.0125 

322 0X142 810.0250 855.0250 

323 0X143 810.0375 855.0375 

324 0X144 810.0500 855.0500 

325 0X145 810.0625 855.0625 

326 0X146 810.0750 855.0750 

327 0X147 810.0875 855.0875 

328 0X148 810.1000 855.1000 

329 0X149 810.1125 855.1125 

330 0X14A 810.1250 855.1250 

331 0X14B 810.1375 855.1375 

332 0X14C 810.1500 855.1500 

333 0X14D 810.1625 855.1625 

334 0X14E 810.1750 855.1750 

335 0X14F 810.1875 855.1875 

336 0X150 810.2000 855.2000 

337 0X151 810.2125 855.2125 

338 0X152 810.2250 855.2250 

339 0X153 810.2375 855.2375 

340 0X154 810.2500 855.2500 

341 0X155 810.2625 855.2625 

342 0X156 810.2750 855.2750 

343 0X157 810.2875 855.2875 

344 0X158 810.3000 855.3000 

345 0X159 810.3125 855.3125 
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346 0X15A 810.3250 855.3250 

347 0X15B 810.3375 855.3375 

348 0X15C 810.3500 855.3500 

349 0X15D 810.3625 855.3625 

350 0X15E 810.3750 855.3750 

351 0X15F 810.3875 855.3875 

352 0X160 810.4000 855.4000 

353 0X161 810.4125 855.4125 

354 0X162 810.4250 855.4250 

355 0X163 810.4375 855.4375 

356 0X164 810.4500 855.4500 

357 0X165 810.4625 855.4625 

358 0X166 810.4750 855.4750 

359 0X167 810.4875 855.4875 

360 0X168 810.5000 855.5000 

361 0X169 810.5125 855.5125 

362 0X16A 810.5250 855.5250 

363 0X16B 810.5375 855.5375 

364 0X16C 810.5500 855.5500 

365 0X16D 810.5625 855.5625 

366 0X16E 810.5750 855.5750 

367 0X16F 810.5875 855.5875 

368 0X170 810.6000 855.6000 

369 0X171 810.6125 855.6125 

370 0X172 810.6250 855.6250 

371 0X173 810.6375 855.6375 

372 0X174 810.6500 855.6500 
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373 0X175 810.6625 855.6625 

374 0X176 810.6750 855.6750 

375 0X177 810.6875 855.6875 

376 0X178 810.7000 855.7000 

377 0X179 810.7125 855.7125 

378 0X17A 810.7250 855.7250 

379 0X17B 810.7375 855.7375 

380 0X17C 810.7500 855.7500 

381 0X17D 810.7625 855.7625 

382 0X17E 810.7750 855.7750 

383 0X17F 810.7875 855.7875 

384 0X180 810.8000 855.8000 

385 0X181 810.8125 855.8125 

386 0X182 810.8250 855.8250 

387 0X183 810.8375 855.8375 

388 0X184 810.8500 855.8500 

389 0X185 810.8625 855.8625 

390 0X186 810.8750 855.8750 

391 0X187 810.8875 855.8875 

392 0X188 810.9000 855.9000 

393 0X189 810.9125 855.9125 

394 0X18A 810.9250 855.9250 

395 0X18B 810.9375 855.9375 

396 0X18C 810.9500 855.9500 

397 0X18D 810.9625 855.9625 

398 0X18E 810.9750 855.9750 

399 0X18F 810.9875 855.9875 
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400 0X190 811.0000 856.0000 

401 0X191 811.0125 856.0125 

402 0X192 811.0250 856.0250 

403 0X193 811.0375 856.0375 

404 0X194 811.0500 856.0500 

405 0X195 811.0625 856.0625 

406 0X196 811.0750 856.0750 

407 0X197 811.0875 856.0875 

408 0X198 811.1000 856.1000 

409 0X199 811.1125 856.1125 

410 0X19A 811.1250 856.1250 

411 0X19B 811.1375 856.1375 

412 0X19C 811.1500 856.1500 

413 0X19D 811.1625 856.1625 

414 0X19E 811.1750 856.1750 

415 0X19F 811.1875 856.1875 

416 0X1A0 811.2000 856.2000 

417 0X1A1 811.2125 856.2125 

418 0X1A2 811.2250 856.2250 

419 0X1A3 811.2375 856.2375 

420 0X1A4 811.2500 856.2500 

421 0X1A5 811.2625 856.2625 

422 0X1A6 811.2750 856.2750 

423 0X1A7 811.2875 856.2875 

424 0X1A8 811.3000 856.3000 

425 0X1A9 811.3125 856.3125 

426 0X1AA 811.3250 856.3250 
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427 0X1AB 811.3375 856.3375 

428 0X1AC 811.3500 856.3500 

429 0X1AD 811.3625 856.3625 

430 0X1AE 811.3750 856.3750 

431 0X1AF 811.3875 856.3875 

432 0X1B0 811.4000 856.4000 

433 0X1B1 811.4125 856.4125 

434 0X1B2 811.4250 856.4250 

435 0X1B3 811.4375 856.4375 

436 0X1B4 811.4500 856.4500 

437 0X1B5 811.4625 856.4625 

438 0X1B6 811.4750 856.4750 

439 0X1B7 811.4875 856.4875 

440 0X1B8 811.5000 856.5000 

441 0X1B9 811.5125 856.5125 

442 0X1BA 811.5250 856.5250 

443 0X1BB 811.5375 856.5375 

444 0X1BC 811.5500 856.5500 

445 0X1BD 811.5625 856.5625 

446 0X1BE 811.5750 856.5750 

447 0X1BF 811.5875 856.5875 

448 0X1C0 811.6000 856.6000 

449 0X1C1 811.6125 856.6125 

450 0X1C2 811.6250 856.6250 

451 0X1C3 811.6375 856.6375 

452 0X1C4 811.6500 856.6500 

453 0X1C5 811.6625 856.6625 
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454 0X1C6 811.6750 856.6750 

455 0X1C7 811.6875 856.6875 

456 0X1C8 811.7000 856.7000 

457 0X1C9 811.7125 856.7125 

458 0X1CA 811.7250 856.7250 

459 0X1CB 811.7375 856.7375 

460 0X1CC 811.7500 856.7500 

461 0X1CD 811.7625 856.7625 

462 0X1CE 811.7750 856.7750 

463 0X1CF 811.7875 856.7875 

464 0X1D0 811.8000 856.8000 

465 0X1D1 811.8125 856.8125 

466 0X1D2 811.8250 856.8250 

467 0X1D3 811.8375 856.8375 

468 0X1D4 811.8500 856.8500 

469 0X1D5 811.8625 856.8625 

470 0X1D6 811.8750 856.8750 

471 0X1D7 811.8875 856.8875 

472 0X1D8 811.9000 856.9000 

473 0X1D9 811.9125 856.9125 

474 0X1DA 811.9250 856.9250 

475 0X1DB 811.9375 856.9375 

476 0X1DC 811.9500 856.9500 

477 0X1DD 811.9625 856.9625 

478 0X1DE 811.9750 856.9750 

479 0X1DF 811.9875 856.9875 

480 0X1E0 812.0000 857.0000 
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481 0X1E1 812.0125 857.0125 

482 0X1E2 812.0250 857.0250 

483 0X1E3 812.0375 857.0375 

484 0X1E4 812.0500 857.0500 

485 0X1E5 812.0625 857.0625 

486 0X1E6 812.0750 857.0750 

487 0X1E7 812.0875 857.0875 

488 0X1E8 812.1000 857.1000 

489 0X1E9 812.1125 857.1125 

490 0X1EA 812.1250 857.1250 

491 0X1EB 812.1375 857.1375 

492 0X1EC 812.1500 857.1500 

493 0X1ED 812.1625 857.1625 

494 0X1EE 812.1750 857.1750 

495 0X1EF 812.1875 857.1875 

496 0X1F0 812.2000 857.2000 

497 0X1F1 812.2125 857.2125 

498 0X1F2 812.2250 857.2250 

499 0X1F3 812.2375 857.2375 

500 0X1F4 812.2500 857.2500 

501 0X1F5 812.2625 857.2625 

502 0X1F6 812.2750 857.2750 

503 0X1F7 812.2875 857.2875 

504 0X1F8 812.3000 857.3000 

505 0X1F9 812.3125 857.3125 

506 0X1FA 812.3250 857.3250 

507 0X1FB 812.3375 857.3375 
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508 0X1FC 812.3500 857.3500 

509 0X1FD 812.3625 857.3625 

510 0X1FE 812.3750 857.3750 

511 0X1FF 812.3875 857.3875 

512 0X200 812.4000 857.4000 

513 0X201 812.4125 857.4125 

514 0X202 812.4250 857.4250 

515 0X203 812.4375 857.4375 

516 0X204 812.4500 857.4500 

517 0X205 812.4625 857.4625 

518 0X206 812.4750 857.4750 

519 0X207 812.4875 857.4875 

520 0X208 812.5000 857.5000 

521 0X209 812.5125 857.5125 

522 0X20A 812.5250 857.5250 

523 0X20B 812.5375 857.5375 

524 0X20C 812.5500 857.5500 

525 0X20D 812.5625 857.5625 

526 0X20E 812.5750 857.5750 

527 0X20F 812.5875 857.5875 

528 0X210 812.6000 857.6000 

529 0X211 812.6125 857.6125 

530 0X212 812.6250 857.6250 

531 0X213 812.6375 857.6375 

532 0X214 812.6500 857.6500 

533 0X215 812.6625 857.6625 

534 0X216 812.6750 857.6750 
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535 0X217 812.6875 857.6875 

536 0X218 812.7000 857.7000 

537 0X219 812.7125 857.7125 

538 0X21A 812.7250 857.7250 

539 0X21B 812.7375 857.7375 

540 0X21C 812.7500 857.7500 

541 0X21D 812.7625 857.7625 

542 0X21E 812.7750 857.7750 

543 0X21F 812.7875 857.7875 

544 0X220 812.8000 857.8000 

545 0X221 812.8125 857.8125 

546 0X222 812.8250 857.8250 

547 0X223 812.8375 857.8375 

548 0X224 812.8500 857.8500 

549 0X225 812.8625 857.8625 

550 0X226 812.8750 857.8750 

551 0X227 812.8875 857.8875 

552 0X228 812.9000 857.9000 

553 0X229 812.9125 857.9125 

554 0X22A 812.9250 857.9250 

555 0X22B 812.9375 857.9375 

556 0X22C 812.9500 857.9500 

557 0X22D 812.9625 857.9625 

558 0X22E 812.9750 857.9750 

559 0X22F 812.9875 857.9875 

560 0X230 813.0000 858.0000 

561 0X231 813.0125 858.0125 
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562 0X232 813.0250 858.0250 

563 0X233 813.0375 858.0375 

564 0X234 813.0500 858.0500 

565 0X235 813.0625 858.0625 

566 0X236 813.0750 858.0750 

567 0X237 813.0875 858.0875 

568 0X238 813.1000 858.1000 

569 0X239 813.1125 858.1125 

570 0X23A 813.1250 858.1250 

571 0X23B 813.1375 858.1375 

572 0X23C 813.1500 858.1500 

573 0X23D 813.1625 858.1625 

574 0X23E 813.1750 858.1750 

575 0X23F 813.1875 858.1875 

576 0X240 813.2000 858.2000 

577 0X241 813.2125 858.2125 

578 0X242 813.2250 858.2250 

579 0X243 813.2375 858.2375 

580 0X244 813.2500 858.2500 

581 0X245 813.2625 858.2625 

582 0X246 813.2750 858.2750 

583 0X247 813.2875 858.2875 

584 0X248 813.3000 858.3000 

585 0X249 813.3125 858.3125 

586 0X24A 813.3250 858.3250 

587 0X24B 813.3375 858.3375 

588 0X24C 813.3500 858.3500 
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589 0X24D 813.3625 858.3625 

590 0X24E 813.3750 858.3750 

591 0X24F 813.3875 858.3875 

592 0X250 813.4000 858.4000 

593 0X251 813.4125 858.4125 

594 0X252 813.4250 858.4250 

595 0X253 813.4375 858.4375 

596 0X254 813.4500 858.4500 

597 0X255 813.4625 858.4625 

598 0X256 813.4750 858.4750 

599 0X257 813.4875 858.4875 

600 0X258 813.5000 858.5000 

601 0X259 813.5125 858.5125 

602 0X25A 813.5250 858.5250 

603 0X25B 813.5375 858.5375 

604 0X25C 813.5500 858.5500 

605 0X25D 813.5625 858.5625 

606 0X25E 813.5750 858.5750 

607 0X25F 813.5875 858.5875 

608 0X260 813.6000 858.6000 

609 0X261 813.6125 858.6125 

610 0X262 813.6250 858.6250 

611 0X263 813.6375 858.6375 

612 0X264 813.6500 858.6500 

613 0X265 813.6625 858.6625 

614 0X266 813.6750 858.6750 

615 0X267 813.6875 858.6875 
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616 0X268 813.7000 858.7000 

617 0X269 813.7125 858.7125 

618 0X26A 813.7250 858.7250 

619 0X26B 813.7375 858.7375 

620 0X26C 813.7500 858.7500 

621 0X26D 813.7625 858.7625 

622 0X26E 813.7750 858.7750 

623 0X26F 813.7875 858.7875 

624 0X270 813.8000 858.8000 

625 0X271 813.8125 858.8125 

626 0X272 813.8250 858.8250 

627 0X273 813.8375 858.8375 

628 0X274 813.8500 858.8500 

629 0X275 813.8625 858.8625 

630 0X276 813.8750 858.8750 

631 0X277 813.8875 858.8875 

632 0X278 813.9000 858.9000 

633 0X279 813.9125 858.9125 

634 0X27A 813.9250 858.9250 

635 0X27B 813.9375 858.9375 

636 0X27C 813.9500 858.9500 

637 0X27D 813.9625 858.9625 

638 0X27E 813.9750 858.9750 

639 0X27F 813.9875 858.9875 

640 0X280 814.0000 859.0000 

641 0X281 814.0125 859.0125 

642 0X282 814.0250 859.0250 
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643 0X283 814.0375 859.0375 

644 0X284 814.0500 859.0500 

645 0X285 814.0625 859.0625 

646 0X286 814.0750 859.0750 

647 0X287 814.0875 859.0875 

648 0X288 814.1000 859.1000 

649 0X289 814.1125 859.1125 

650 0X28A 814.1250 859.1250 

651 0X28B 814.1375 859.1375 

652 0X28C 814.1500 859.1500 

653 0X28D 814.1625 859.1625 

654 0X28E 814.1750 859.1750 

655 0X28F 814.1875 859.1875 

656 0X290 814.2000 859.2000 

657 0X291 814.2125 859.2125 

658 0X292 814.2250 859.2250 

659 0X293 814.2375 859.2375 

660 0X294 814.2500 859.2500 

661 0X295 814.2625 859.2625 

662 0X296 814.2750 859.2750 

663 0X297 814.2875 859.2875 

664 0X298 814.3000 859.3000 

665 0X299 814.3125 859.3125 

666 0X29A 814.3250 859.3250 

667 0X29B 814.3375 859.3375 

668 0X29C 814.3500 859.3500 

669 0X29D 814.3625 859.3625 
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670 0X29E 814.3750 859.3750 

671 0X29F 814.3875 859.3875 

672 0X2A0 814.4000 859.4000 

673 0X2A1 814.4125 859.4125 

674 0X2A2 814.4250 859.4250 

675 0X2A3 814.4375 859.4375 

676 0X2A4 814.4500 859.4500 

677 0X2A5 814.4625 859.4625 

678 0X2A6 814.4750 859.4750 

679 0X2A7 814.4875 859.4875 

680 0X2A8 814.5000 859.5000 

681 0X2A9 814.5125 859.5125 

682 0X2AA 814.5250 859.5250 

683 0X2AB 814.5375 859.5375 

684 0X2AC 814.5500 859.5500 

685 0X2AD 814.5625 859.5625 

686 0X2AE 814.5750 859.5750 

687 0X2AF 814.5875 859.5875 

688 0X2B0 814.6000 859.6000 

689 0X2B1 814.6125 859.6125 

690 0X2B2 814.6250 859.6250 

691 0X2B3 814.6375 859.6375 

692 0X2B4 814.6500 859.6500 

693 0X2B5 814.6625 859.6625 

694 0X2B6 814.6750 859.6750 

695 0X2B7 814.6875 859.6875 

696 0X2B8 814.7000 859.7000 
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697 0X2B9 814.7125 859.7125 

698 0X2BA 814.7250 859.7250 

699 0X2BB 814.7375 859.7375 

700 0X2BC 814.7500 859.7500 

701 0X2BD 814.7625 859.7625 

702 0X2BE 814.7750 859.7750 

703 0X2BF 814.7875 859.7875 

704 0X2C0 814.8000 859.8000 

705 0X2C1 814.8125 859.8125 

706 0X2C2 814.8250 859.8250 

707 0X2C3 814.8375 859.8375 

708 0X2C4 814.8500 859.8500 

709 0X2C5 814.8625 859.8625 

710 0X2C6 814.8750 859.8750 

711 0X2C7 814.8875 859.8875 

712 0X2C8 814.9000 859.9000 

713 0X2C9 814.9125 859.9125 

714 0X2CA 814.9250 859.9250 

715 0X2CB 814.9375 859.9375 

716 0X2CC 814.9500 859.9500 

717 0X2CD 814.9625 859.9625 

718 0X2CE 814.9750 859.9750 

719 0X2CF 814.9875 859.9875 

720 0X2D0 815.0000 860.0000 

721 0X2D1 815.0125 860.0125 

722 0X2D2 815.0250 860.0250 

723 0X2D3 815.0375 860.0375 
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724 0X2D4 815.0500 860.0500 

725 0X2D5 815.0625 860.0625 

726 0X2D6 815.0750 860.0750 

727 0X2D7 815.0875 860.0875 

728 0X2D8 815.1000 860.1000 

729 0X2D9 815.1125 860.1125 

730 0X2DA 815.1250 860.1250 

731 0X2DB 815.1375 860.1375 

732 0X2DC 815.1500 860.1500 

733 0X2DD 815.1625 860.1625 

734 0X2DE 815.1750 860.1750 

735 0X2DF 815.1875 860.1875 

736 0X2E0 815.2000 860.2000 

737 0X2E1 815.2125 860.2125 

738 0X2E2 815.2250 860.2250 

739 0X2E3 815.2375 860.2375 

740 0X2E4 815.2500 860.2500 

741 0X2E5 815.2625 860.2625 

742 0X2E6 815.2750 860.2750 

743 0X2E7 815.2875 860.2875 

744 0X2E8 815.3000 860.3000 

745 0X2E9 815.3125 860.3125 

746 0X2EA 815.3250 860.3250 

747 0X2EB 815.3375 860.3375 

748 0X2EC 815.3500 860.3500 

749 0X2ED 815.3625 860.3625 

750 0X2EE 815.3750 860.3750 
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751 0X2EF 815.3875 860.3875 

752 0X2F0 815.4000 860.4000 

753 0X2F1 815.4125 860.4125 

754 0X2F2 815.4250 860.4250 

755 0X2F3 815.4375 860.4375 

756 0X2F4 815.4500 860.4500 

757 0X2F5 815.4625 860.4625 

758 0X2F6 815.4750 860.4750 

759 0X2F7 815.4875 860.4875 

760 0X2F8 815.5000 860.5000 

761 0X2F9 815.5125 860.5125 

762 0X2FA 815.5250 860.5250 

763 0X2FB 815.5375 860.5375 

764 0X2FC 815.5500 860.5500 

765 0X2FD 815.5625 860.5625 

766 0X2FE 815.5750 860.5750 

767 0X2FF 815.5875 860.5875 

768 0X300 815.6000 860.6000 

769 0X301 815.6125 860.6125 

770 0X302 815.6250 860.6250 

771 0X303 815.6375 860.6375 

772 0X304 815.6500 860.6500 

773 0X305 815.6625 860.6625 

774 0X306 815.6750 860.6750 

775 0X307 815.6875 860.6875 

776 0X308 815.7000 860.7000 

777 0X309 815.7125 860.7125 
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778 0X30A 815.7250 860.7250 

779 0X30B 815.7375 860.7375 

780 0X30C 815.7500 860.7500 

781 0X30D 815.7625 860.7625 

782 0X30E 815.7750 860.7750 

783 0X30F 815.7875 860.7875 

784 0X310 815.8000 860.8000 

785 0X311 815.8125 860.8125 

786 0X312 815.8250 860.8250 

787 0X313 815.8375 860.8375 

788 0X314 815.8500 860.8500 

789 0X315 815.8625 860.8625 

790 0X316 815.8750 860.8750 

791 0X317 815.8875 860.8875 

792 0X318 815.9000 860.9000 

793 0X319 815.9125 860.9125 

794 0X31A 815.9250 860.9250 

795 0X31B 815.9375 860.9375 

796 0X31C 815.9500 860.9500 

797 0X31D 815.9625 860.9625 

798 0X31E 815.9750 860.9750 

799 0X31F 815.9875 860.9875 

800 0X320 816.0000 861.0000 

801 0X321 816.0125 861.0125 

802 0X322 816.0250 861.0250 

803 0X323 816.0375 861.0375 

804 0X324 816.0500 861.0500 
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805 0X325 816.0625 861.0625 

806 0X326 816.0750 861.0750 

807 0X327 816.0875 861.0875 

808 0X328 816.1000 861.1000 

809 0X329 816.1125 861.1125 

810 0X32A 816.1250 861.1250 

811 0X32B 816.1375 861.1375 

812 0X32C 816.1500 861.1500 

813 0X32D 816.1625 861.1625 

814 0X32E 816.1750 861.1750 

815 0X32F 816.1875 861.1875 

816 0X330 816.2000 861.2000 

817 0X331 816.2125 861.2125 

818 0X332 816.2250 861.2250 

819 0X333 816.2375 861.2375 

820 0X334 816.2500 861.2500 

821 0X335 816.2625 861.2625 

822 0X336 816.2750 861.2750 

823 0X337 816.2875 861.2875 

824 0X338 816.3000 861.3000 

825 0X339 816.3125 861.3125 

826 0X33A 816.3250 861.3250 

827 0X33B 816.3375 861.3375 

828 0X33C 816.3500 861.3500 

829 0X33D 816.3625 861.3625 

830 0X33E 816.3750 861.3750 

831 0X33F 816.3875 861.3875 
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832 0X340 816.4000 861.4000 

833 0X341 816.4125 861.4125 

834 0X342 816.4250 861.4250 

835 0X343 816.4375 861.4375 

836 0X344 816.4500 861.4500 

837 0X345 816.4625 861.4625 

838 0X346 816.4750 861.4750 

839 0X347 816.4875 861.4875 

840 0X348 816.5000 861.5000 

841 0X349 816.5125 861.5125 

842 0X34A 816.5250 861.5250 

843 0X34B 816.5375 861.5375 

844 0X34C 816.5500 861.5500 

845 0X34D 816.5625 861.5625 

846 0X34E 816.5750 861.5750 

847 0X34F 816.5875 861.5875 

848 0X350 816.6000 861.6000 

849 0X351 816.6125 861.6125 

850 0X352 816.6250 861.6250 

851 0X353 816.6375 861.6375 

852 0X354 816.6500 861.6500 

853 0X355 816.6625 861.6625 

854 0X356 816.6750 861.6750 

855 0X357 816.6875 861.6875 

856 0X358 816.7000 861.7000 

857 0X359 816.7125 861.7125 

858 0X35A 816.7250 861.7250 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)



RayFish Product Family Manual

Appendix B Frequency Tables

B-33

HARRIS PROPRIETARY / USC TITLE 18 WARNING: EXPORT-CONTROLLED DOCUMENT

859 0X35B 816.7375 861.7375 

860 0X35C 816.7500 861.7500 

861 0X35D 816.7625 861.7625 

862 0X35E 816.7750 861.7750 

863 0X35F 816.7875 861.7875 

864 0X360 816.8000 861.8000 

865 0X361 816.8125 861.8125 

866 0X362 816.8250 861.8250 

867 0X363 816.8375 861.8375 

868 0X364 816.8500 861.8500 

869 0X365 816.8625 861.8625 

870 0X366 816.8750 861.8750 

871 0X367 816.8875 861.8875 

872 0X368 816.9000 861.9000 

873 0X369 816.9125 861.9125 

874 0X36A 816.9250 861.9250 

875 0X36B 816.9375 861.9375 

876 0X36C 816.9500 861.9500 

877 0X36D 816.9625 861.9625 

878 0X36E 816.9750 861.9750 

879 0X36F 816.9875 861.9875 

880 0X370 817.0000 862.0000 

881 0X371 817.0125 862.0125 

882 0X372 817.0250 862.0250 

883 0X373 817.0375 862.0375 

884 0X374 817.0500 862.0500 

885 0X375 817.0625 862.0625 
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886 0X376 817.0750 862.0750 

887 0X377 817.0875 862.0875 

888 0X378 817.1000 862.1000 

889 0X379 817.1125 862.1125 

890 0X37A 817.1250 862.1250 

891 0X37B 817.1375 862.1375 

892 0X37C 817.1500 862.1500 

893 0X37D 817.1625 862.1625 

894 0X37E 817.1750 862.1750 

895 0X37F 817.1875 862.1875 

896 0X380 817.2000 862.2000 

897 0X381 817.2125 862.2125 

898 0X382 817.2250 862.2250 

899 0X383 817.2375 862.2375 

900 0X384 817.2500 862.2500 

901 0X385 817.2625 862.2625 

902 0X386 817.2750 862.2750 

903 0X387 817.2875 862.2875 

904 0X388 817.3000 862.3000 

905 0X389 817.3125 862.3125 

906 0X38A 817.3250 862.3250 

907 0X38B 817.3375 862.3375 

908 0X38C 817.3500 862.3500 

909 0X38D 817.3625 862.3625 

910 0X38E 817.3750 862.3750 

911 0X38F 817.3875 862.3875 

912 0X390 817.4000 862.4000 
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913 0X391 817.4125 862.4125 

914 0X392 817.4250 862.4250 

915 0X393 817.4375 862.4375 

916 0X394 817.4500 862.4500 

917 0X395 817.4625 862.4625 

918 0X396 817.4750 862.4750 

919 0X397 817.4875 862.4875 

920 0X398 817.5000 862.5000 

921 0X399 817.5125 862.5125 

922 0X39A 817.5250 862.5250 

923 0X39B 817.5375 862.5375 

924 0X39C 817.5500 862.5500 

925 0X39D 817.5625 862.5625 

926 0X39E 817.5750 862.5750 

927 0X39F 817.5875 862.5875 

928 0X3A0 817.6000 862.6000 

929 0X3A1 817.6125 862.6125 

930 0X3A2 817.6250 862.6250 

931 0X3A3 817.6375 862.6375 

932 0X3A4 817.6500 862.6500 

933 0X3A5 817.6625 862.6625 

934 0X3A6 817.6750 862.6750 

935 0X3A7 817.6875 862.6875 

936 0X3A8 817.7000 862.7000 

937 0X3A9 817.7125 862.7125 

938 0X3AA 817.7250 862.7250 

939 0X3AB 817.7375 862.7375 
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940 0X3AC 817.7500 862.7500 

941 0X3AD 817.7625 862.7625 

942 0X3AE 817.7750 862.7750 

943 0X3AF 817.7875 862.7875 

944 0X3B0 817.8000 862.8000 

945 0X3B1 817.8125 862.8125 

946 0X3B2 817.8250 862.8250 

947 0X3B3 817.8375 862.8375 

948 0X3B4 817.8500 862.8500 

949 0X3B5 817.8625 862.8625 

950 0X3B6 817.8750 862.8750 

951 0X3B7 817.8875 862.8875 

952 0X3B8 817.9000 862.9000 

953 0X3B9 817.9125 862.9125 

954 0X3BA 817.9250 862.9250 

955 0X3BB 817.9375 862.9375 

956 0X3BC 817.9500 862.9500 

957 0X3BD 817.9625 862.9625 

958 0X3BE 817.9750 862.9750 

959 0X3BF 817.9875 862.9875 

960 0X3C0 818.0000 863.0000 

961 0X3C1 818.0125 863.0125 

962 0X3C2 818.0250 863.0250 

963 0X3C3 818.0375 863.0375 

964 0X3C4 818.0500 863.0500 

965 0X3C5 818.0625 863.0625 

966 0X3C6 818.0750 863.0750 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)

Mobile Station 
Outbound Frequency (MHz)

Mobile Station 
Inbound Frequency (MHz)



RayFish Product Family Manual

Appendix B Frequency Tables

B-37

HARRIS PROPRIETARY / USC TITLE 18 WARNING: EXPORT-CONTROLLED DOCUMENT

967 0X3C7 818.0875 863.0875 

968 0X3C8 818.1000 863.1000 

969 0X3C9 818.1125 863.1125 

970 0X3CA 818.1250 863.1250 

971 0X3CB 818.1375 863.1375 

972 0X3CC 818.1500 863.1500 

973 0X3CD 818.1625 863.1625 

974 0X3CE 818.1750 863.1750 

975 0X3CF 818.1875 863.1875 

976 0X3D0 818.2000 863.2000 

977 0X3D1 818.2125 863.2125 

978 0X3D2 818.2250 863.2250 

979 0X3D3 818.2375 863.2375 

980 0X3D4 818.2500 863.2500 

981 0X3D5 818.2625 863.2625 

982 0X3D6 818.2750 863.2750 

983 0X3D7 818.2875 863.2875 

984 0X3D8 818.3000 863.3000 

985 0X3D9 818.3125 863.3125 

986 0X3DA 818.3250 863.3250 

987 0X3DB 818.3375 863.3375 

988 0X3DC 818.3500 863.3500 

989 0X3DD 818.3625 863.3625 

990 0X3DE 818.3750 863.3750 

991 0X3DF 818.3875 863.3875 

992 0X3E0 818.4000 863.4000 

993 0X3E1 818.4125 863.4125 
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994 0X3E2 818.4250 863.4250 

995 0X3E3 818.4375 863.4375 

996 0X3E4 818.4500 863.4500 

997 0X3E5 818.4625 863.4625 

998 0X3E6 818.4750 863.4750 

999 0X3E7 818.4875 863.4875 

1000 0X3E8 818.5000 863.5000 

1001 0X3E9 818.5125 863.5125 

1002 0X3EA 818.5250 863.5250 

1003 0X3EB 818.5375 863.5375 

1004 0X3EC 818.5500 863.5500 

1005 0X3ED 818.5625 863.5625 

1006 0X3EE 818.5750 863.5750 

1007 0X3EF 818.5875 863.5875 

1008 0X3F0 818.6000 863.6000 

1009 0X3F1 818.6125 863.6125 

1010 0X3F2 818.6250 863.6250 

1011 0X3F3 818.6375 863.6375 

1012 0X3F4 818.6500 863.6500 

1013 0X3F5 818.6625 863.6625 

1014 0X3F6 818.6750 863.6750 

1015 0X3F7 818.6875 863.6875 

1016 0X3F8 818.7000 863.7000 

1017 0X3F9 818.7125 863.7125 

1018 0X3FA 818.7250 863.7250 

1019 0X3FB 818.7375 863.7375 

1020 0X3FC 818.7500 863.7500 
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1021 0X3FD 818.7625 863.7625 

1022 0X3FE 818.7750 863.7750 

1023 0X3FF 818.7875 863.7875 

1024 0X400 818.8000 863.8000 

1025 0X401 818.8125 863.8125 

1026 0X402 818.8250 863.8250 

1027 0X403 818.8375 863.8375 

1028 0X404 818.8500 863.8500 

1029 0X405 818.8625 863.8625 

1030 0X406 818.8750 863.8750 

1031 0X407 818.8875 863.8875 

1032 0X408 818.9000 863.9000 

1033 0X409 818.9125 863.9125 

1034 0X40A 818.9250 863.9250 

1035 0X40B 818.9375 863.9375 

1036 0X40C 818.9500 863.9500 

1037 0X40D 818.9625 863.9625 

1038 0X40E 818.9750 863.9750 

1039 0X40F 818.9875 863.9875 

1040 0X410 819.0000 864.0000 

1041 0X411 819.0125 864.0125 

1042 0X412 819.0250 864.0250 

1043 0X413 819.0375 864.0375 

1044 0X414 819.0500 864.0500 

1045 0X415 819.0625 864.0625 

1046 0X416 819.0750 864.0750 

1047 0X417 819.0875 864.0875 
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1048 0X418 819.1000 864.1000 

1049 0X419 819.1125 864.1125 

1050 0X41A 819.1250 864.1250 

1051 0X41B 819.1375 864.1375 

1052 0X41C 819.1500 864.1500 

1053 0X41D 819.1625 864.1625 

1054 0X41E 819.1750 864.1750 

1055 0X41F 819.1875 864.1875 

1056 0X420 819.2000 864.2000 

1057 0X421 819.2125 864.2125 

1058 0X422 819.2250 864.2250 

1059 0X423 819.2375 864.2375 

1060 0X424 819.2500 864.2500 

1061 0X425 819.2625 864.2625 

1062 0X426 819.2750 864.2750 

1063 0X427 819.2875 864.2875 

1064 0X428 819.3000 864.3000 

1065 0X429 819.3125 864.3125 

1066 0X42A 819.3250 864.3250 

1067 0X42B 819.3375 864.3375 

1068 0X42C 819.3500 864.3500 

1069 0X42D 819.3625 864.3625 

1070 0X42E 819.3750 864.3750 

1071 0X42F 819.3875 864.3875 

1072 0X430 819.4000 864.4000 

1073 0X431 819.4125 864.4125 

1074 0X432 819.4250 864.4250 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number
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Carrier 
Number

(Hex)

Mobile Station 
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Mobile Station 
Inbound Frequency (MHz)
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1075 0X433 819.4375 864.4375 

1076 0X434 819.4500 864.4500 

1077 0X435 819.4625 864.4625 

1078 0X436 819.4750 864.4750 

1079 0X437 819.4875 864.4875 

1080 0X438 819.5000 864.5000 

1081 0X439 819.5125 864.5125 

1082 0X43A 819.5250 864.5250 

1083 0X43B 819.5375 864.5375 

1084 0X43C 819.5500 864.5500 

1085 0X43D 819.5625 864.5625 

1086 0X43E 819.5750 864.5750 

1087 0X43F 819.5875 864.5875 

1088 0X440 819.6000 864.6000 

1089 0X441 819.6125 864.6125 

1090 0X442 819.6250 864.6250 

1091 0X443 819.6375 864.6375 

1092 0X444 819.6500 864.6500 

1093 0X445 819.6625 864.6625 

1094 0X446 819.6750 864.6750 

1095 0X447 819.6875 864.6875 

1096 0X448 819.7000 864.7000 

1097 0X449 819.7125 864.7125 

1098 0X44A 819.7250 864.7250 

1099 0X44B 819.7375 864.7375 

1100 0X44C 819.7500 864.7500 

1101 0X44D 819.7625 864.7625 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)
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Mobile Station 
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1102 0X44E 819.7750 864.7750 

1103 0X44F 819.7875 864.7875 

1104 0X450 819.8000 864.8000 

1105 0X451 819.8125 864.8125 

1106 0X452 819.8250 864.8250 

1107 0X453 819.8375 864.8375 

1108 0X454 819.8500 864.8500 

1109 0X455 819.8625 864.8625 

1110 0X456 819.8750 864.8750 

1111 0X457 819.8875 864.8875 

1112 0X458 819.9000 864.9000 

1113 0X459 819.9125 864.9125 

1114 0X45A 819.9250 864.9250 

1115 0X45B 819.9375 864.9375 

1116 0X45C 819.9500 864.9500

1117 0X45D 819.9625 864.9625 

1118 0X45E 819.9750 864.9750 

1119 0X45F 819.9875 864.9875 

1120 0X460 820.0000 865.0000 

1121 0X461 820.0125 865.0125 

1122 0X462 820.0250 865.0250 

1123 0X463 820.0375 865.0375 

1124 0X464 820.0500 865.0500 

1125 0X465 820.0625 865.0625 

1126 0X466 820.0750 865.0750 

1127 0X467 820.0875 865.0875 

1128 0X468 820.1000 865.1000 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number

(Decimal)

Carrier 
Number

(Hex)
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Outbound Frequency (MHz)

Mobile Station 
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1129 0X469 820.1125 865.1125 

1130 0X46A 820.1250 865.1250 

1131 0X46B 820.1375 865.1375 

1132 0X46C 820.1500 865.1500 

1133 0X46D 820.1625 865.1625 

1134 0X46E 820.1750 865.1750 

1135 0X46F 820.1875 865.1875 

1136 0X470 820.2000 865.2000 

1137 0X471 820.2125 865.2125 

1138 0X472 820.2250 865.2250 

1139 0X473 820.2375 865.2375 

1140 0X474 820.2500 865.2500 

1141 0X475 820.2625 865.2625 

1142 0X476 820.2750 865.2750 

1143 0X477 820.2875 865.2875 

1144 0X478 820.3000 865.3000 

1145 0X479 820.3125 865.3125 

1146 0X47A 820.3250 865.3250 

1147 0X47B 820.3375 865.3375 

1148 0X47C 820.3500 865.3500 

1149 0X47D 820.3625 865.3625 

1150 0X47E 820.3750 865.3750 

1151 0X47F 820.3875 865.3875 

1152 0X480 820.4000 865.4000 

1153 0X481 820.4125 865.4125 

1154 0X482 820.4250 865.4250 

1155 0X483 820.4375 865.4375 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
Number
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Carrier 
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(Hex)
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1156 0X484 820.4500 865.4500 

1157 0X485 820.4625 865.4625 

1158 0X486 820.4750 865.4750 

1159 0X487 820.4875 865.4875 

1160 0X488 820.5000 865.5000 

1161 0X489 820.5125 865.5125 

1162 0X48A 820.5250 865.5250 

1163 0X48B 820.5375 865.5375 

1164 0X48C 820.5500 865.5500 

1165 0X48D 820.5625 865.5625 

1166 0X48E 820.5750 865.5750 

1167 0X48F 820.5875 865.5875 

1168 0X490 820.6000 865.6000 

1169 0X491 820.6125 865.6125 

1170 0X492 820.6250 865.6250 

1171 0X493 820.6375 865.6375 

1172 0X494 820.6500 865.6500 

1173 0X495 820.6625 865.6625 

1174 0X496 820.6750 865.6750 

1175 0X497 820.6875 865.6875 

1176 0X498 820.7000 865.7000 

1177 0X499 820.7125 865.7125 

1178 0X49A 820.7250 865.7250 

1179 0X49B 820.7375 865.7375 

1180 0X49C 820.7500 865.7500 

1181 0X49D 820.7625 865.7625 

1182 0X49E 820.7750 865.7750 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
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1183 0X49F 820.7875 865.7875 

1184 0X4A0 820.8000 865.8000 

1185 0X4A1 820.8125 865.8125 

1186 0X4A2 820.8250 865.8250 

1187 0X4A3 820.8375 865.8375 

1188 0X4A4 820.8500 865.8500 

1189 0X4A5 820.8625 865.8625 

1190 0X4A6 820.8750 865.8750 

1191 0X4A7 820.8875 865.8875 

1192 0X4A8 820.9000 865.9000 

1193 0X4A9 820.9125 865.9125 

1194 0X4AA 820.9250 865.9250 

1195 0X4AB 820.9375 865.9375 

1196 0X4AC 820.9500 865.9500 

1197 0X4AD 820.9625 865.9625 

1198 0X4AE 820.9750 865.9750 

1199 0X4AF 820.9875 865.9875 

Table B-1.  iDEN Frequency Table (Continued)

Carrier 
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(Decimal)

Carrier 
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C-1 WARRANTY TERMS

Harris Corporation - Wireless Products Group

Effective Date: February 15, 2011

This is a Maintenance Agreement between Harris Corporation, acting through is Government Communications 
Systems Division, (“Harris”) and the Buyer or User of the Equipment (collectively, the “Buyer”). Harris and the 
Buyer agree as follows:

1.  Definitions. In addition to the terms defined in the Agreement, capitalized terms used herein have the fol-
lowing meanings:

a.  “Agreement” means the instrument of contracting; such as a Purchase Order, or other such desig-
nation which these terms and conditions of sale for Wireless Equipment, Software and Services are 
incorporated.

b.  “Buyer” means the purchaser of the Equipment, Software, or Services from Harris. 

c.  “Date of Acceptance” means the date when the Customer receives an item of Equipment, Software 
and/or Services unless Customer otherwise notifies Harris in writing that the Equipment, Software 
and/or Services was delivered in a defective condition.

d.  “Equipment” means any Harris Wireless Products Group hardware and accessories, including com-
ponents, but excluding any Software or Services.

e.  “Harris” means Harris Corporation, acting through its Government Communications Systems Divi-
sion, Wireless Products Group.

f.  “Purchase Order” means the Customer’s purchase order as acknowledged by Harris on its standard 
acknowledgement form.

g.  “Purchase Price” means the purchase price as identified in the Purchase Order. 

h.  “Quote” means the price quotation of Harris itemizing the purchase price and includes all exhibits 
referred to within such Quote, including but not limited to the technical proposal, technical specifica-
tions, scope of work, schedule, the Agreement and any maintenance agreement specifically 
included in the purchase price.

i.  “Services” means training, maintenance support, or other services to be provided to Customer as 
part of the Agreement.

j.  “Software” means software and firmware, including all copies provided to Customer.

k.  “User” means the actual end-user of the Equipment if such person or entity is not the same as the 
Buyer.

2.  Standard Limited 12-Month Maintenance Agreement.

a.  Scope. This Maintenance Agreement applies to all Harris Equipment purchased under the Agree-
ment and used for the purposes normally intended, except for Equipment specifically excluded.

Appendix

C WARRANTY
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b.  Term. This Maintenance Agreement is valid for one (1) year from the date of Equipment purchase.

c.  Repair or Replacement. Harris will, at its option, repair or replace the defective Equipment or defec-
tive part of the Equipment without charge to the Buyer. Buyer must notify Harris in writing of any 
defect within ten (10) days from the date of Buyer’s discovery of the defect. If Harris confirms that a 
defect exists and Harris is unable to resolve the problem without having the Equipment shipped to 
Harris, then Harris will, at its option and its cost, repair or replace the defective Equipment or defec-
tive part and return the Equipment to the Buyer, provided however, that the repair or replacement is 
due to a cause covered under this Maintenance Agreement. The foregoing is the sole and exclu-
sive remedy under this Maintenance Agreement.

3.  Items Excluded from this Maintenance Agreement. The following are not covered under this Mainte-
nance Agreement:

a.  Defects or failures caused by Buyer or User abuse or misuse of the Equipment.

b.  Defects or failures caused by unauthorized attempts to repair or alter the Equipment in any way.

c.  Items of temporary and/or inherently indeterminate life, such as bulbs, fuses, batteries, etc.

4.  Maintenance Agreement Service Warranty.

a.  Any repair service performed by Harris under this Agreement is warranted to be free from defects in 
material or workmanship for sixty (60) days from the date of repair or the remaining term of this 
Agreement, whichever is longer. All terms and exclusions of this Maintenance Agreement apply to 
such warranty.

b.  HARRIS MAKES NO OTHER AGREEMENTS BEYOND THE EXPRESS MAINTENANCE AGREE-
MENT AS CONTAINED HEREIN. ALL EXPRESS OR IMPLIED WARRANTIES OF FITNESS FOR 
A PARTICULAR PURPOSE OR MERCHANTABILITY ARE EXCLUDED. IN NO EVENT SHALL 
HARRIS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE, EXEMPLARY OR 
CONSEQUENTIAL DAMAGES, ARISING FROM OR RELATING TO THE PERFORMANCE OR 
NONPERFORMANCE OF THIS MAINTENANCE AGREEMENT OR ANY ACTS OR OMISSIONS 
RELATED TO THE USE OF ANY EQUIPMENT DELIVERED OR SERVICES FURNISHED HERE-
UNDER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE, LOSS OF PROFITS, OR 
LOSS OF BENEFICIAL USE, EVEN IF HARRIS HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. THIS LIMITATION SHALL APPLY TO ANY CLAIM OR CAUSE OF ACTION 
WHETHER IN CONTRACT OR TORT (INCLUDING NEGLIGENCE, STRICT LIABILITY OR 
BREACH OF WARRANTY).

5.  Extended Annual Maintenance Agreement. Upon expiration of the Standard Limited 12-Month Mainte-
nance Agreement as described in Paragraph 2, an Extended Annual Maintenance Agreement may be pur-
chased for the Equipment. Pricing for annual maintenance is available by quote upon written request. 
Extended Annual Maintenance Agreements will be referenced to the top level serial number of the Equip-

NOTE
This Maintenance Agreements also includes:

• Customer Telephone Support (8 am – 6 pm ET)
• Warranty on hardware
• Notification of and free access to software upgrades as 

released
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ment for which the original Maintenance Agreement was purchased. Software protocols and peripheral 
controllers also will be covered under the Extended Annual Maintenance Agreement. However, if an addi-
tional software protocol is purchased after the initial purchase of Equipment, the Maintenance Agreement 
will be extended for one (1) year at no additional cost to the Buyer from the purchase date of the additional 
protocol.

6.  Payment Terms. Domestic Purchase Orders for Maintenance Agreements require full payment of the Pur-
chase Price prior to the start of the term of the Maintenance Agreement and of Harris’ obligation to perform.

7.  Restricted Use. The Equipment covered under this Maintenance Agreement is a restricted use item and 
can only be sold to authorized U.S. government agencies, or other authorized users, pursuant to 18 U.S.C. 
§ 2510 et seq. Use of Equipment is strictly governed by applicable federal, state and local law associated 
with the intercept and monitoring of oral communications. Harris assumes no liability for any use, misuse or 
improper use of the Equipment and makes no representations as to Equipment suitability for any specific 
application. Buyer’s right to transfer, sell or assign the Equipment shall be limited to authorized law enforce-
ment and government agencies with the prior written consent of Harris.

8.  Compliance with Laws. Buyer shall comply with all applicable federal, state and local laws, regulations, 
rules and orders related to the use of the Equipment.

9.  U.S. export License and Transfer Approvals. Buyer represents and warrants that no technical data fur-
nished related to the Equipment shall be disclosed to any foreign nation, person, firm, or country, nor shall 
any technical data be exported from the United States without first complying with all requirements of the 
International Traffic in Arms Regulations (ITAR) or the Export Administration Regulations (EAR), including 
the requirement for obtaining any export license if applicable. Buyer shall first obtain the written consent of 
Harris prior to submitting any request for authority to export any such technical data. If Buyer receives 
export controlled information and improperly discloses such information provided Harris properly identified 
the information as export controlled at the time of Buyer’s receipt, Buyer shall to the fullest extent permitted 
by law indemnify and hold Harris harmless from all claims, demands, damages, costs, fines, penalties, 
attorney’s fees, and all other expenses arising from failure of the Buyer to comply with this clause or with 
the ITAR or EAR, and from any third party claims or noncompliance by Buyer, its agents or employees.

10.  Pricing. The Equipment is being sold in accordance with the current price list published by Harris. Prices 
and the terms and conditions of sale are subject to change without notice.

11.  License. By acceptance of delivery and/or use of the Equipment, the Buyer grants Harris a nonexclusive, 
nontransferable, worldwide, paid-up license to use the Software and documentation only on the designated 
Equipment and in conjunction with the Agreement and with Harris’ customary business operations. Buyer 
shall not copy the Software and all Software, manuals and associated documentation remain the property 
of the Harris or of the Software developer or licensor. No transfer of ownership or rights in technical data, 
patents, copyrights or trade secrets are expressed or implied.

12.  Rights to Inventions. All Inventions are and shall at all times remain Harris’ Confidential Information. All 
rights, title and interest in and to the Inventions, including all intellectual property rights, remain vested in 
Harris, its suppliers or licensors, subject only to the license grant below. For purposes hereof, “Inventions” 
shall mean and include all ideas, concepts, know-how, techniques, inventions, discoveries, improvements, 
specifications, designs, methods, devices, systems, reports, studies, computer software (in object or source 
code), programming and other documentation, flow charts, diagrams and all other information or tangible 
material of any nature whatsoever (in any medium and in any stage of development or completion) included 
in or resulting from the Equipment, that are conceived, designed, practiced, prepared, produced or devel-
oped by Harris or any of its personnel during the course of Buyer’s use of the Equipment.
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